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Introduction 
This walkthrough introduces you to the processes involved in producing custom 
formats in Practice CS. After you have completed the walkthrough, you will be able 
to apply the custom formatting features of Practice CS. 

Note: This walkthrough assumes you are familiar with using Practice CS or that you 
have read chapter 3, Program Overview, in the Practice CS Getting Started guide.  

Opening the sample database 
To perform the exercises in this walkthrough, you will start Practice CS and log in to 
the Sample database as staff CAT. To log in, follow these steps.  

1. Start Practice CS.  

2. In the Login dialog, select Sample in the Open Firm field. 

3. In the Staff ID field, select CAT. 

Note: If you previously marked the Remember login information checkbox, 
press and hold the SHIFT key as you double-click the Practice CS icon. 
Continue to hold the SHIFT key until the login dialog appears.  

 

http://cs.thomsonreuters.com/ua/_pdfs/practice/cs_us_en/external/practice_getting_started.pdf
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4. Click OK.  

 

Backing up the sample database 
Data that you enter while performing the exercises in this walkthrough will affect the 
Sample database. Therefore, we recommend that you make a backup of the 
Sample database before you begin so that it is available for use in other Practice 
CS walkthroughs.  

Note: If you are running Practice CS through the Virtual Office CS® module, the 
Backup menu command is not available. We recommend that you install a local 
copy of Practice CS so that you can back up the sample database. For instructions 
on installing the program, please see chapter 2, Installation Instructions, in the 
Practice CS Getting Started guide.  

To back up the Sample database, follow these steps.  

1. In Practice CS, choose File > Backup. 

PRACTICE CS
partoftheCSPROFESSIONALSUITE?

Qpen Firm: Sample

Staff ID: CAT

THOMSONREUTERS
Version 2014.X.X

OK Cancel

 

 

 

  

  

 
 

 

http://cs.thomsonreuters.com/ua/_pdfs/practice/cs_us_en/external/practice_getting_started.pdf
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2. Click the  button next to the Backup File field and if necessary, navigate to 
the folder where you want to save the backup file. The backup file will have a 
file extension of BDF.   

Note: The backup file will be created on the computer where the data resides. 
The path specified here must be a valid path on that computer.   

 
3. Click OK.  

4. When prompted that the backup is complete, click OK.   

 

Note: After you complete this walkthrough, you can restore the sample database. 
For instructions, see “Restoring the sample database” on page 83. 

  

Backup Firm X

Please enter the path and file name for your Firm database backup file.

Backup file: c:\ProgramFiles(x86)\MicrosoftSQLServer\MSSQL10_50.CREATIVESOLUTION\MS

Schedule a recurrinq backup

OK Cancel

Practice CS X

The backup is complete.

OK
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Customizing invoice and statement 
formats 

The Practice CS Sample database comes with several predefined statement and 
invoice formats that you may use as setup suggestions. You can also use the 
powerful custom format editor to create your own. You can use the existing default 
format, create a new format based on an existing format, or create a new format 
from scratch.  

Adding a new custom statement format 
For this walkthrough, you will create a new statement format based on an existing 
one. 

1. From the Setup menu, choose Custom Formats.  

 

 

[PracticeCS-[Sample}-[CutomFomats] X
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ÿÿÿ
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Fields
ÿ

Activity loiceFomat
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Engagement Invoice Format

Project mvoice Fomat
Project wTme Entry Comments and Det

Suatements
Project with Details Invoice Format

3Repors
lOn l Sta

Navigation Pane
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dss Labels Properses
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In the Custom Formats list, notice the existing formats for both invoices and 
statements. For this walkthrough, you will create a new format based on All 
Open Items Statement Format. 

2. Right-click the All Open Items Statement Format and choose Copy Format.  

 
A new format called All Open Items Statement Format (2) appears in the list. 

3. Right-click All Open Items Statement Format (2) and choose Edit.  

 
The format opens in the center pane. You may want to unpin the Custom 
Formats pane to better see the editing pane.  

4. In the toolbar, click the Format Wizard button.  

The Format Wizard opens. In this wizard, you can choose the information that 
appears in the statement format. 

Custom Formats
Invoices
Activities by Activity Type

P
ÿ

P

ÿ

Project w/Time Entry Comments and Det

Statements
All Open Items Statem

Reports Add Invoice...
? Lists
? Production

Billing Add Report...
+ Collection Add Label/Letter...
ÿ Reconciliation Copy Format

Labels &Letters
ÿ Address Labels

W

+ Delete
ÿ Letters

Custom Formats

Invoices
Activities by Activity Type
Activity by Engagement
Activity Invoice Format
Engagement InvoiceFormat
Entry Detail by Engagement
Project Invoice Format
Project w/Time Entry Comments and Det
Project with DetailsInvoice Format

Slatements
All Open ltems Statement Format
All Open Items Statement Format I

Reports Add Invoice...
+ Lists Add Statement...
+ Production
+ Billing Add Report...
+ Collection Add Label/Letter...
+ Reconciliation

Labels &Letters Copy Format
+ Address Labels 1P3

File Folder Labels Delete
+ Letters
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5. In the Main tab of the Format Wizard, enter walkthrough as the name of the 
new statement format.  

 
6. Click the Next button to move to the Heading Information tab. Make no changes 

in this tab. 

7. Click the Next button to move to the A/R Information tab. Make no changes in 
this tab. 

8. Click the Next button to move to the Pay Stub Information tab. In this tab, 
unmark the Client Phone Number checkbox to remove the client’s phone 
number from the pay stub.  

 
9. Click the Finish button to close the Format Wizard. 

Statement Format Wizard

Main Heading InfomationA/R InfomationPay Stub Infomation

This wizard helps you create statement formats. Visit each tab and select the
Pames, Volane, Martinez & Ce., CPAs information you would like to include. You can click Finish at any time to
520 WofFRd  5u8s 110  Abary NY 12206 complete the wizard. After the wizard is complete, your statement layout will be
Phos: 600-668:0600Enait: JGmihgPVICPAs.oonWeli:www,PVMCPAA.c0Wdisplayed and you can modify the format as needed.

Wenty/s Oid Fastiet
Chae/ce inghan

Ds: 63/91/2585

Abery, NY 12253
1645 Westem Aae

Date Tioe Deta Owe
08/0106Bogineing Boleree $1,880.00

Bolonee

00/24/06
00/0606Recaipt CM 8623

1,120.82
1,000.80

2,800.02

059106Aso De
1,800.02

$1,800.02 Enter a description for this format:
walkthroughl

Bogining Balonoe
veiDes

$1680.00
Receipis

1,120.02
Adutin

(1,00.00)0.00
Gunice Chargea

51,80.0
0.00

sust Dus

1,120.02 680.00
Ioll

Detke 05512995

Weed/s CMR
51886-46702

Ced Typ
Cerd #:

Anoumt Dus:$1,889.82
Anoumt Endosed: 5_

Sigustare

Back Next Finish Cancel

Statement Format Wizard

Main Heading InfomationA/R InfomationPay Stub Infomation

Select whether you would like to include a pay stub at the bottom of your
Pames,Velano,Marinez & Co,CPAs statement format and the information that should show in the pay stub.

Pto.600660600
520 WofF Rd 5uBa 110 ± Abarn NY 1206

Ensit: JGmin@PVMCPAs.5Wel:ww.PVMCPA.cW

Wenty/s Old Fastie
Clay/ice Inghan

D: 0391/2895

Abery, NY 1213
1545 WelemAms  Include a pay stub

Too Deta
08/0106Beginring Bolonee

Cvel
$1,0

Bolonce

Pay Stub Information
00/24/06
00/08/06Racept Chk 86623

1,120.02
1,000.80

2,800.02
1,000.02

$1,800.02 Client ID Amount Due
1000
1,120.02 Client Name Amount Enclosed Line

Receipis (1,000.00)0.00
Sanice Chagea

$1,00.0
0.00

rust Dus Client Phone Number!Credit Card Payment Information

Statement Date AR Terms

1,120.00 60.00 4.00

rioe vfhpayrent Dete 0512595

594664702Wendys OtdFa

CadTg
Cerd#:

Anoumt Dus:$1,699.02
Frp Dete Aroumt Encosed: 5_

Signsture:

Back Next Finish Cancel
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Editing formats 
You can use the Custom Formats setup screen to customize invoice and statement 
formats to suit your firm’s needs. In the following exercises you will format text, 
move and align items, add a logo, and add additional text. 

Formatting text and repositioning items 
1. In the editing pane, scroll down to the pay stub at the bottom of the statement 

and click the “Amount Enclosed” text.  

2. Click the Bold button  in the toolbar to make the text boldface. 

3. The text box is now too small to contain the boldface text. Click and drag the 
handle at the center of the left side of the box toward the left, then release the 
mouse button. Repeat as necessary until the full text appears.  

 
4. Click the “Amount Due” text above the “Amount Enclosed” text box, press and 

hold the SHIFT key, then click the “[AR” text box.   

  
5. Click and drag the two items you selected until they are just above the “Amount 

Enclosed” text box.   

 
6. Click the “Amount Enclosed” text box, press and hold the SHIFT key, then click 

the “Amount Due” text box.  

 
7. Now that both boxes are selected, you can align them along their left edges by 

clicking the Align Lefts button  in the toolbar.  

B

AmountEnclosed:
7

gAmount DEDo[AR
ÿ

AmountEnclosed:$

AmiountDue:

AmountEnclosed:
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8. With both boxes still selected, press the left arrow key on the keyboard multiple 
times to move them to the left and clear of the text boxes on the right.  

 
9. Click the “[AR” text box, press and hold the SHIFT key, then click the text box 

immediately below. 

10. Click the Align Lefts button  to align the selected text boxes.   

 

Adding a logo 
You can add a logo to a statement by marking the Logo checkbox in the Heading 
Information tab of the Format Wizard, but that restricts the image you insert to the 
header portion of the statement. The following method enables you to add a logo to 
any part of a statement. 

For the current statement format, first we need to delete the old logo. 

lick the colorful logo at the top of the statement format, then press the 
DELETE key.   

 

lick the Image  button on the toolbar. The cursor changes to crosshairs.  

3. Click the location where you want the image to appear, hold down the left 
mouse button, and drag to create a box for the image. Release the mouse 
button when finished. You can move and resize this box later if necessary.  

X

Amount Due: [AR

AmountEnclosed:

Amount Due: AR

AmountEnclosed:$

walkthrough

ReportHeader

ParnesVelanoMartinez&Co
Certified Public Accountants

[Mailing City State Zip]
Phone: [ContactPhone phone] E-mail:[ContactEmail Web:[Contact

1. C

2. C
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4. With the image box selected, click the Image field in the Properties pane.  

 
5. Click the  button in the Image field, navigate to the image file you want to 

add, and click Open to insert the image into the box you created. For this 
walkthrough, choose an image on your computer, preferably a simple one.   

6. In most cases, the image will not properly fit the box you created. In the 
Properties pane, select Zoom in the SizeMode field. This zooms the image to fit 
within the box you created.  

 
 

walkthrough

ReportHeader

[Contact Address address 1]
[Mailing City State Zip]

Phone: [Contact Phone phone] E-mail:[Contact Email

111

walkthrough Fields
Client
ÿ Standard Chart

ReportHeader Custom Chart
Custom Formula

PVW Parnes Velano Martinez 8 Co + Firm
Client

Certifed Public Accomtants

[Contact Address address 1]
[Mailing City State Zip]

Phone:[Contact Phone phone] E-mail:[Contact Email Web:[Contact L

Properties
ÿÿÿ

[Contact name] Date:[Rer X 0.0208
[Client name 1]: Y 0.0208
[Contact Address address 1]: Appearance
[Contact Address address 2] > (lmage) System.D
[Mailing City State Zip] AlignmentCenter

BackColor Transparen
LineColor Transparen

STATEMENT LineStyle Transparent
Line'weight0

SizeMode PageHeader Zoom
Behavior

[Firm name 1] : Page:[Page Nurmber]:of [Pa! Visible True

StatementHeader SizeMode
Indicates how the image is sized to Detail fit within the picture's area.

 

 

 
 

  

  
 

  
   

 
 

  
 

 

 
 

   

 
 

    
   

  
    

   
  

  
 

  
  

   
 

    
  

 



Customizing invoice and statement formats 

Practice CS Custom Formatting WalkThrough 11 

7. Move the image to its desired location. 

Tip: To move an item in the format designer, you can either click and drag the 
item, or select it and press the arrow keys. Hold down the CTRL key and press 
the arrow keys to move the item in larger increments. 

Previewing a statement 
1. Click the Preview button  in the toolbar to preview the statement and check 

the image’s size and positioning. 

2. The Preview Custom Statement Format dialog enables you to choose a client 
for whom to preview the statement. Highlight the item for client AAC and click 
OK.  

 
When the preview window appears, notice the changes you made to the format. 
The logo appears where you placed it.  

Preview Custom Statement Format

 Select the client to use to preview this format.

Statement date: Period End Date4/30/2014 

 Statement activity date range:Period-to-date 4/1/2014 10 4/30/2014

Filter

ID Description AR Balance
BROWNJ Brown, Jerald & Elizabeth 350.00
ACEADVERT Ace Advertising 6,450.00
ANIMAL Animal Shelter 101 55,049.64
CRAWFORD Crawford's Steak House 1,025.00
PROTO Prototype Design 4,880.76
AAC Advanced Advertising Consultan 5.396.00

QK Cancel
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3. Scroll down to the bottom and notice that the client phone number does not 

appear on the pay stub (a change you made in the Format Wizard), and the 
“Amount Enclosed” text is boldface and aligned with the text above it.  

 
4. Close the preview window. Make additional changes to the format as 

necessary. 

Preview Custom Statement Format

ÿ100% IK<>1/1

PVW Parnes Velano Martinez 8 Co
Certifed Pobic Accomtants

880 Technology Drive
Ann Arbor, MI 48108

Phone: (800) 968-8900 E-mail: Info@p.v.m.co. Web: www.pvmco.com
com

Peter Wells Date: 04/30/2014
Advanced Advertising Consultants
9425 Main Street
Suite C
Albany. NY 12205

STATEMENT
Date Type Reference Due Date Debit Credit Balance
02/28/14 Invoice #337 2014-MICHIGAN-SAM02/28/14 5,396.00 5,396.00
04/30/14 Amount Due $5,396.00

Preview Custom Statement Format
 Back -  - e

ÿ 100%

04/30/2014 03/31/2014 02/28/2014 01/31/2014 12/31/2013+ Total
0.00 0.00 5,396.00 0.00 0.00 $5,396.00

Your balance is past due - please remit payment.

Please returm this portion with payment. Date: 04/30/2014
ID:AAC
Advanced Advertising Consultants

Card Type: OSCOVER VSA Amount Due: $5,396.00
Card #: Exp Date: Amount Enclosed:$

Signature:
Invoices are due upon receipt. Your prompt payment is appreciated. Allbalances over 30 days will be assessed a

service charge of 18%.
10
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Adding additional text 
You can add text to your statements by adding text boxes. 

1. Click the Textbox button  in the toolbar.  

2. Click the location where you want the text box to appear, hold down the left 
mouse button, and drag to create a text box of the approximate size you need. 
Release the mouse button when finished. You can move and resize this text 
box later if necessary. 

For this walkthrough, add a text box below the “Amount Enclosed” box at the 
bottom of the statement.  

3. To edit the text, double-click the text box. You can also click within the 
OutputValue field in the Properties pane to activate the field. Then click the  
button next to that field to open the OutputValue Formula dialog.  

 

111

walkthrough Fields
Client
ÿ· Standard Chart

ÿ Custom Chart
Custom Formula
Firm

ÿ Client

ooter

:Footer
Properties

Detail Line [Detail Line [Detail Line [Detail Line [Detail Line Total ÿÿ
[AR [AR [AR [AR [AR [AR AlignDecima False

[Client:Dunning Message] AlignmentLeft
BackColor Transparen

1turm.this portion with.payment. Date: [Report Date] CharacterSp0
Font Arial, 10pt

lient)] ForeColor 0'0'0
-me 1]: LineSpacing 0

OutputForme
Outputvalue

DISCOVER VISA Amount Due: [AR Padding2 0'0ÿ0ÿ0
VerticalAlign TopExp Date. AmountEnclosed: Behavior

TextBox2 OutputVaue
[Firm accounts:receivable.terms]ÿ The textbox content, with data

formulas contained inside brackets.

III

Main A/R Open ltems
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4. In the OutputValue Formula dialog, enter Thank you! Click OK when finished.   

 
5. Format the text using the toolbar. Change it to Times New Roman, 14 pt, bold, 

italic, and center-aligned.  

 

 
6. Preview the statement and then move, resize, or reformat the text box as 

necessary. 

7. Click the Save button  in the toolbar to save your changes.  

8. Click the Close button  in the toolbar to close your custom statement format.   
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Customizing Report Formats 
Practice CS enables you to create custom reports that present firm data the way 
you want to see it. Using a default Practice CS report as a starting point, you can 
choose the data you want reported and the format in which it should appear. 

Additionally, you can export the custom report formats you create so they can be 
used for other databases. You can even share custom report formats with others in 
the profession, and download formats that others have shared. 

The Custom Formats setup screen, which you may already have used to customize 
invoice and statement formats, provides the tools you will need to create your own 
custom reports. 

This chapter provides information on creating, copying, and editing report formats, 
previewing and printing your customized formats, restoring defaults for standard 
reports, importing and exporting custom report formats, and security options for the 
Custom Formats setup screen. 

Adding new custom report formats 
Custom report formats are based on existing standard reports in Practice CS, 
though your flexibility in customizing those reports is virtually unlimited. For this 
walkthrough, add a new custom report following these steps. 

1. Choose Setup > Custom Formats to open the Custom Formats setup screen. 

2. Click the Add Document button  on the toolbar and choose Add Report 
from the available commands. The Report Format Wizard opens.   

3. In the Report Format Wizard, enter My Report as the description for the new 
report in the first field. 

 

+
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4. In the list of Standard Reports on the left, expand the folder that contains the 
report on which you want to base your custom report, then select that report. 
For this example, base the new report on the Clients report under Lists.   

 
5. Click Finish to close the Report Format Wizard and return to the Custom 

Formats screen with the report open in the format editor. 

lick the Save button.

Copying report formats 
If you want to base a new custom report on a report that you previously customized, 
you can create a copy of the previous report to serve as the basis for the new 
report. 

Report FormatWizard

Main

Standard Reports This wizard helps you create report formats. Select a standard report as a
starting point for this custom report. You can click Finish at any time to

Lists complete the wizard. After the wizard is complete, your report layout wil be
Activities displayed and you can modify the format as needed.

Activity Categories
Client Groupings
Client/Engagement Enter a description for this format:
Chents My Report
Contacts
Departments
Engagement Categories
Engagement Termplates Selected standard report for this format:
Entities Clients
Staff Biling R ates
Staff Groupings
Staff Levels
Standard Text

Production
Billing

ÿ Collection
ÿ Reconcilation

Finish Cancel

6. C     
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1. In the list of reports in the Custom Formats screen, right-click My Report and 
choose Copy Format from the context menu.   

 
This adds a new report to the list named My Report (2). 

2. Right-click the copy and choose Edit from the context menu. The report opens 

in the format editor. You can now click the Format Wizard button to change 
the name of the report, or begin customizing the report in the editor.   

3. For this exercise, click the Close button  on the toolbar.   

Editing report formats 
The format editor on the Custom Formats screen enables you to make numerous 
changes to report formats. You will use the custom report you added previously to 
explore these changes. 

Adding and removing columns 
One of the basic operations in customizing reports is to add and remove columns 
from a report. For this exercise, you will add a new column to the report you created 
earlier. 

Moving columns 
ight-click My Report in the list of reports and choose Edit from the context 

menu. 

2. Unpin the list of reports. To do this, click the pin in the upper-right corner of 
the list pane.  This enlarges your work area. 

Reports
ÿ Lists

Activities
Activity Categories
Client Groupings
Client/Engagement
Clients
Contacts
Departments
Engagement Categories
Engagement Templates
Entities
My Repo-
Staff Billi Add Invoice...
Staff Gro Add Statement...
Staff Lev
Standard Add Report...

+ Production Add Label/Letter...
+ Billing Copy Format
+ Collection
+ Reconciliatid 1IP3

ÿ Labels&Letters Delete

  

1. R
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3. Click the  button next to the ReportHeader section label to hide the 
ReportHeader section, which contains cover sheet information that we will not 
need for this exercise.   

 
You will now move columns around to create room for a new column. 

4. In the format editor, select the Primary Address text box in the PageHeader 
section. 

My Report

ReportHeader

List of [Plural Term
Report Options Sel

Report Date: [Report Date Option]

[Filter Option Selection(1)] [Filter Option Method(1)]
[Filter Option Selection(2)] [Filter Option Method(2)]
[Filter Option Selection(3)] [Filter Option Method(3)]
[Filter Option Selection(4)] [Filter Option Method(4)]
[Filter Option Selection(5)] [Filter Option Method(5)]
[Filter Option Selection(6)] [Filter Option Method(6)]

[Group By Selection(1] [Group By Sort On(1)]
[Detail By Selection] [Detail By Sort On]

[CheckBox Option(PrintCharts)]

PageHeader

[Firm name 1]

List of [Plural Term
[Report Date Hea

ID Description Primary Address
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5. While holding down the CTRL key, select the Primary Phone and E-mail boxes 
in the PageHeader section., Then, in the Detail section, select the three 
address boxes, the Contact Phone phone box, and the Contact Email email 
box, as shown in the illustration below.   

 
6. Press the right arrow key to move all of the boxes to the right. Open up enough 

space to insert a column to the left of the address. 

Moving the columns also moved the right edge of the e-mail boxes out of the 
printable area of the report. Now you will temporarily expand the right margin 
and re-size the two affected boxes. 

7. In the ruler at the top of the editor, position the mouse cursor so it becomes a 
double-sided arrow at the right margin, then click and drag the margin to the 
right until the ends of the e-mail boxes are shown.   

 

Note: You may need to drag the margin a little, then use the horizontal scroll 
bar to scroll to the right, then drag a little more, and so on. 

8. Click within the editor to deselect the boxes you selected previously, then select 
the E-mail box in the PageHeader section, press SHIFT, and select the Contact 
Email email box below it.  

ReportHeader

PageHeader

[Firmname1]

List of [Plural Term(Client)]
[Report Date Header]

Description Primary Address rimaryPhone :-mail

[Group ID(1)][GroupDescription(1)]

Detail
[ID(Client)] [Description(Client)] [Contact Address address 1] fContact Phone phone]Contact Emallemail]

Cees

ÿ

1101

Primary Phone E-mail
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9. With the two boxes selected, hold the SHIFT key and press the left arrow key 
until the right edges of the boxes align with the original right margin, as shown 
below.   

 
10. Drag the right margin back to its original position (10½ inches). 

Inserting a column 
Now you will insert a new column. For this exercise, you will add an A/R Ending 
Balance column to the report. 

1. Click the Text Box button  on the toolbar. The cursor becomes a crosshair.   

2. Position the cursor in the PageHeader section at the upper-right corner of the 
Description text box, then click and drag to open a new text box between the 
Description and Primary Address boxes.   

 
3. Double-click the new text box to open the OutputValue dialog. 

PrimaryPhone E-mail

[Contact:Phone phone]: : [Contact:Email email]

abl

ReportHeader

PageHeader

[Firmname1]

List of [Plural Term(Client)]
[Report Date Header]

Description TextBox1 PrimaryAddress

GroupHeaderl
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4. In the text entry area at the bottom of the dialog, enter A/R Ending Balance. 
Then click OK to return to the editor.   

 

5. With the A/R Ending Balance text box selected, click the Center button  on 
the toolbar to center the text in the box.   

?  Output Value Formula

Description:TextBox1

Client System Fomulas
 Custom Formula  Date Parts

ÿÿFirm ÿDates
ÿReport Expressions
ÿ-ÿ Client Formatted Dates

-FormattedNumbers
ÿMath

+[

Summary Properties Aggregate FunctionIFExpression

Calculation Method - Valid only for dates and numeric values (valid for dates: Avg. Min, Max).[Sum 
(  a  as ose s si o o o s dn ps - er 

None
'see peni dnog ro o penn onas q u si -i ns

Reset Add Custom Fomula OK Cancel 

  
  

 
  

  
  

   
 

 

 

   

 

 

 

   



Customizing Report Formats 

22 Practice CS Custom Formatting WalkThrough 

n the Fields pane on the right side of the editor, expand the Client item. Then 
expand the A/R item beneath Client and the Aging item beneath A/R, as shown 
in the following illustration.   

 
7. Click the Ending Balance item and drag it into the Detail section of the editor, 

positioning it beneath the A/R Ending Balance text box you just created.   

 
8. Click the Font Size drop-down on the toolbar and change the font size to 8.   

 

9. Click the Center button  on the toolbar to center the text in the box.   

iybdidnice

Standard Chart
Custom Chart
Custom Formula

Firm
Report

List of [Plural Term(Client)] ÿ Client
24Period History

[Report Date Header] ÿÿAR
ÿActivity

A/R Ending Balance Primary Address Primary Phone E-mail ÿÿAging
Beginning Balance

First Period
Inner Period

Last Period
ÿCollection

ÿ [Aging Ending [Contact Address address 1] [Contact Phone phone] [Contact Email ema ÿ Last A/R Entry Amount
ÿ 11117711 [Contact Address address 2] LastA/R Entry Date

ÿ Service Charge Past Du

Properties

ÿ Add -

Tahoma 8 BI

6

10

11
12
14
16
18

6. I
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Aligning items 
Now you will need to align the boxes you added to their neighbors and to each 
other. 

1. Select the A/R Ending Balance text box you added in the PageHeader section, 
then press SHIFT and select the Description box to its left. 

2. Click the Align Tops button  on the toolbar.   

3. Click in empty space to deselect all boxes. 

4. Align the Aging Ending Balance box you dragged to the Detail section with the 
box to its left using the same method. Deselect all boxes when finished. 

5. Select the Aging Ending Balance box, then press SHIFT and select the A/R 
Ending Balance box in the PageHeader section. 

6. Click the Make Same Size button  on the toolbar. 

7. Click the Align Lefts button  on the toolbar.   

8. Click the Preview button  on the toolbar to see your changes, using the 
default report options. Close the preview window when finished.   
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Note: Certain Practice CS reports (for example, the Production Analysis report) let 
you include a Detail line 2 by marking the Display controls for Detail line 2 checkbox 
in the format wizard.   

 

When both the first and second detail line controls are visible, as in the following 
illustration, you can tell them apart by clicking the control and looking at the 
RequiredOption property in the Fields pane.   

 

Field properties are discussed further in the next section. 

GroupHeader4 Properties
Detail ÿÿ
GroupFooter4 Behavior
[Detail Group e]c[plibei]Group Description] [Production[Production [Production=100*[Production=100* CanGrow False

[Production[Production[Production=100*[Production=100* CanShrink False
True

GroupFooter3 Visible True
wordwrap[Group Description(3)] Totals [Production [Production[Production =100*[Production =100* True

=100*[Production=100* Summary
[Production [Production [Production SummaryFunctionSun

GroupFooter2 SumnmaryGroupGroupHeader4
SummaryRunningNone

[Group Description(2)]: Totals  ot=uonpoua] oot=uognoua]uognoua]uognioua] SubTotal
[Production[Production[Production=100 *[Production=100 * Suppression

HideDuplicatesFalse
 GroupFooterl Printwhen

[Group Description(1}]: Totals [Production [Production[Production=100 *[Production=100 * RequiredOptionDetailLine2

[Production[Production[Production=100 *[Production=100 * SuppresslfLastlnC0

PageFooter RequiredOpbon
Specifies the custom report option that must
be selected in order for the control to be

StaffDate Time Skazrp7 printed.
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Editing field properties 
The properties for various items included on reports are 
governed by the settings in the Properties pane to the 
right of the format editor. The properties that appear in 
this pane are arranged in the following categories:   

 General — Includes the item’s name, height, width, 
and X and Y coordinates within its section of format 
editor. 

 Appearance — Specifies attributes for alignment, 
transparency, font, and output format and value. 

 Behavior — Governs whether the item can grow or 
shrink, allows multiple lines, is visible, or allows 
word wrapping. 

 Summary — Governs the behavior of summary 
functions, including how subtotals are calculated 
and/or reset between sections. 

 Suppression — Controls suppression of 
duplicates, printing, and final items under certain 
conditions. 

Click an item to see a brief explanation of its purpose 
below the Properties pane. 

Note: You can switch between categorized and 
alphabetical display of properties by clicking the 
Alphabetical button  and Categorized button  at 
the top of the pane.   

 

 

2
A ÿ

Properties

8 ÿÿ
(General)
[ewe N] PageHeader_Desc
Height 0.1875
Width 2
X 0.9375
Y 1.45
Appearance
AliqnDecimal False

Alignment Left
BackColor Transparent
CharacterSpe
Font Tahoma,10pt
ForeColor 000
LineSpacing0
OutputFormat
OutputValueSort Name
Padding 0, 0, 0, 0
VerticalAlignnTop
Behavior
CanGrow True
CanShrink False
MultiLine True
Visible True
Wordwrap True
Summary
SummaryFunc Sum
SummaryGroL
SummaryRun None
SummaryTyp None
Suppression
HideDuplicatt False
Printw/hen
RequiredOpti
SuppresslfLa:0

OutputYalue
The textbox content,with data
formulas contained inside brackets.
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Changing the output format 
In this exercise, you will change output format for the field you added previously. 

1. In the Detail section, select the Aging Ending Balance field from the previous 
exercise. 

2. In the Properties pane, scroll down and select the OutputFormat item, then click 
the browse button that appears.   

 
3. In the OutputFormatDialog, select Currency from the list of categories, then 

click OK.   

 

Changing font properties 
In this exercise, you will change the font of the main report heading. 

1. Select the report title in the format editor.   

111

Properties

ÿ ÿ
(General)
[ewe N] TextBox2
Height 0.1875
Width 1

X 3.19
Y 0 ÿ

Appearance
AlignDecimals False
Alignment Center
BackColor Transparent
CharacterSpe
Font Tahoma,8pt
ForeColor 0.0.0
LineSpacing
OutputFormat#.##0.00

OutputValue[AR Aging[Key(CIe
Padding 0, 0,0, 0
VerticalAlignnTop

Output Format

Category:
General Sample
Number $12,345.00
Currency
Date Decimal places:2

Use 1000 Separator ()
Custom Negative numbers:

-$12,345.00
($12,345.00)

QK Cancel
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2. In the Properties pane, select the Font item, then click the  button that 

appears. This opens the Font dialog.   

3. In the Font dialog, make the following selections: 

 Font — Verdana 

 Font style — Bold 

 Size — 14 

Mark the Underline checkbox, then click OK.   

  
The font for the report title has been changed to match your specifications, as 
shown below.   

 

4. Click the Preview button  on the toolbar to see your changes, using the 
default report options. Close the preview window when finished.   

Note: The value in the field used for the preceding exercise, “List of [Plural 
Term(Client)],” reflects that this field contains an item that uses terminology that can 
be customized within Practice CS to match the terminology used by your firm. 
Terminology can be customized on the Terminology tab of the Firm setup screen. 

List of [Plural Term(Client)]
[Report Date Header]

A/R Ending Balance Primary Address Primary Phone

111

Font

Font: Font style: Size:
Verdana Bold 14 OK

TRAIAN PRO Regular 14

16 18 20 24 26
Cancel

Trebuchet MS Italic
Tw Cen MT Bold
Verdana Bold Italic
Viner Hand ITC

Effecls Sample
Strikeout

AaBbYyZzUnderine!

Script:
Westem

Term(Client)]
[Report Date Header]

Primary Address PrimaryPhone
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Using formulas 
Now you will add a field to the report that contains a calculated amount. Practice CS 
provides a formula editor for this purpose. 

Preparing to add a new column 
Before you add the new field, you will need to clear some space. First, delete the 
E-mail column. 

1. Select the E-mail text box in the PageHeader section, then press SHIFT and 
select the Contact Email email box in the Detail section.   

 
2. Press DELETE. 

Next you will shift columns to the right to open space for the new column. 

3. Select the Primary Address box, then press the CTRL key and select the 
Primary Phone box in the PageHeader section and the three address boxes 
and Contact Phone phone box in the Detail section.   

 
4. Press the right arrow key until the phone boxes are flush with the right margin 

(10½ inches).  

Note: Do not hold down SHIFT or CTRL for this step. 

5. Click in blank space to deselect all selected items. 

Adding a formula 
Now you have space to add a new column. For this column, we need to create a 
custom formula. 

1. In the Fields pane, right-click the Custom Formula item and choose Add 
Custom Formula from the context menu. This opens the Custom Formula 
dialog. 

List of [Plural Term(client)]
[Report Date Header]

nding BalancePrimaryAddress TrimaryPhone
:6:6:: ::::

Ending Balance [ContactAddress address 1] GContact Phonephone]

[Contact Address address 2
7777777777777777777777777

[Primary City State Zp]
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2. In the Description field, enter Average Days to Collection. This will display the 
average number of days between when you invoice a client and when they pay. 

3. On the left side of the dialog, expand the Client, A/R, and Collection items until 
you see the Collect Day Count item, as shown in the following illustration.   

 
4. Double-click Collect Day Count to add it to the formula. 

5. Click the  button to create a division formula.   

Note: When you click one of the operator buttons (add, subtract, multiply 
divide), you will not notice any change until you add another field. The formula 
will then be properly formatted with the operator between the two fields. 

Custom Formula

Description:Average Days to Collection
Client\A/R\Collection\Collect Day Count System Fomulas
ÿReport  Date Parts
ÿÿ Client ÿDates

 24Period History Expressions
AR Formatted Dates

ÿActivity  Formatted Numbers
ÿÿAging ÿMath
Collection

 Applied Count
 Applied Debit Memo Amount
 Applied Invoice Amount
- Applied Service Charge Amount

Collect Day Count
Collected Amount

 Aggregate Function IF Expression

Select the numeric value from the field tree list.
 Summary Function:Sum 

Summary Grouping:Grand Total 

Apply Clear

Reset OK Cancel 
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6. Double-click the Applied Count item from the list to add it to the formula. Check 
to see that your formula matches the one shown in the illustration.   

 
7. Click OK to save the custom formula. It now appears as a sub-item beneath 

Custom Formula in the Fields pane. 

8. Expand the Custom Formula item and drag the Average Days to Collection item 
onto the report in the Detail section, in the empty space you created earlier.   

 
9. With the custom formula field still selected in the editor, scroll down the 

Properties pane to the OutputFormat item.   

 
10. Click the  button to open the Output Format dialog.   

11. In the Decimal Places field, change the value to 0. Then click OK. This modifies 
the numeric output so that it shows integers only, with no decimal places.   

Collection
Applied Count
AppliedDebitMemoAmount

Applied Invoice Amount

AppliedServiceChargeAmount
Collect Day Count
Collected Amount

[Client Collection Collect Day Count(Client, Report Date Period Start(O).Report Date)/ Client Collection Applied Count(Client,Report
DatePeriodStart(O).Report Date)]

My Heport Fields
Custom FomulaVAverage Days lo Collect

[Group By Selectionÿ1ÿ] [Group By Sort Onÿ1ÿ] [Group By Directionÿ1)] [Group By Page
Standard Chart

[Detail By Selection] [Detail By Sort On] [Detail By Direction] CustomFomula
Custom Charl

ÿ

Firm
Average Days to Calleetion

[CheckBoxOptionÿPrintCharts)]
Report

eHeader
Client

namell

Listof[PluralTerm(Client)]
[Report DateHeader]

Description A/R Ending Balance Primary Address Preperies

apHeaderl (General)
D(1ÿ][Group Description(1]] (auRN) TexdBox3

Height 0.1875

ÿ9 [Aging Ending Ualance][Average Dayso[Contact Address address1] X 5.125
D ÿ A

[Prmary City State Zp] Appearance
Aion Decin Fale
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If you need help with the final few tasks below, refer back to the earlier 
exercises in this guide. 

12. Change the font size for the Average Days to Collection box to 8 pt. 

13. Add a new text box to the PageHeader section to serve as a label for the new 
column. Enter Average Days to Collection in the text entry field for the text 
box. 

14. Widen the upper Average Days to Collection box so it fills the available area 
between the neighboring columns. 

15. Select the lower box, then press SHIFT and select the upper Average Days to 
Collection box.   

 

16 Click the Make Same Size button  on the toolbar.   

17. Align the two new boxes with each other by left edges and with their neighbors 
by top edges. 

18. Center the text in both boxes. 

Note: If you make changes to a custom formula after you have already added a 
field that uses the formula to a report, you must replace the previously added field 
for the formula changes to be reflected. 

Output Format

Category:
SampleGeneral

Number 12.345
Currency
Date Decimal places:

Use 1000 Separator (.)
Custom Negative numbers:

-12.345
(12.345)

QK Cancel

[Report Date Header]

A/REndingBalance Average Days to Collection Primary Address

[Aging EndingBalance] [Average Davs to
[ContactAddress ad

[ContactAddress ad

+
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Creating an IF expression 
Practice CS makes it easy to create IF expressions to determine what to print under 
certain conditions. A simple example is to use an IF expression on My Report to 
print “n/a” when the client has no A/R ending balance. 

1. On the My Report format, double-click the [Aging Ending Balance] text box in 
the Detail section to open the OutputValue Formula dialog.  

f necessary, delete everything from the text field below the operator buttons. 

3. Click the IF Expression tab below the text field.  

4. In the left pane at the top of the dialog, click the expand  buttons to expand 
the Client, A/R, and Aging items.   

   

 Output Value Formula

Description: [Aging Ending Balance]
Client\A/R\VAging\Ending Balance System Fomulas

Custom Formula  Date Parts
ÿÿFirm Dates
Report Expressions

 Client Formatted Dates
24Period History Formatted Numbers
ÿÿAR ÿMath

ÿÿActivity
ÿÿ Aging

 Beginning Balance
Ending Balance

 First Period
 Inner Period
 Last Period

 Summary PropertiesAggregate FunctionIF Expression
Select the IF parameters from the field tree list.OperatorEnter the criteria for the condition here.

IF
condition:

Then Otherwise
print: print:

Apply Clear

Reset Add Custom Fomula OK Cancel 
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5. Drag the Ending Balance item to the first field in the If condition row.   

 
6. Leave the = symbol selected in the Operator field. 

7. In the last field of the If condition row, enter the numeral zero (0). 

8. In the Then print field, enter n/a. 

 Output Value Formula

Description: [Aging Ending Balance]
ClientVA/RVAging\Ending Balance System Fomulas

 Custom Formula  Date Parts
ÿ Firm Dates
Report Expressions
ÿ Client Formatted Dates

24Period History Formatted Numbers
ÿÿAR ÿMath

ÿÿActivity
ÿÿ Aging

 Beginning Balance
Ending Balance

 First Period
 Inner Period
 Last Period

 Summary PropertiesAggregate FunctionIF Expression
Select the IF parameters from the field tree list.Operator Enter the criteria for the condition here.

IF [AR Aging(Key(Client), Mnimum Date, Report
condition:Date)

Then Otherwise
print: print:

Apply Clear

Reset Add Custom Fomula OK Cancel
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9. Drag the Ending Balance item (again) to the Otherwise print field.   

 
You have now created an IF expression that says that if the client’s ending 
balance is equal to zero, print “n/a” on the report, but otherwise print the ending 
balance. 

10. Click the Apply button. 

11. Click OK to save the expression, then confirm that you want to save the 
formula. 

  

Output Value Formula

Description: [Aging Ending Balance]
Client\A/R\Aging\Ending Balance System Fomulas
CustomFormula  Date Parts
ÿÿFirm Dates
Report Expressions
ÿ Client Formatted Dates

24Period History Formatted Numbers
ÿÿAR ÿMath

ÿÿActivity
ÿ-ÿ Aging

 Beginning Balance
Ending Balance

 First Period
 Inner Period
 Last Period

 Summary PropertiesAggregate FunctionIF Expression
Select the IF parameters from the field tree list.Operator Enter the criteria for the condition here.

IF [AR Aging(Key(Client), Minimum Date, Report0
condition:Date)]
Then n/a Otherwise[AR Aging(Key(Client), Minimum Date, Report 
print: print: Date)

Apply Clear

Reset Add Custom Fomula OK Cancel 
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12. Click the Preview button, leave the default options, and click OK to preview 
the report. Several clients with zero balances show “n/a” in the A/R Ending 
Balance column.   

 

13. Close the preview window and click the Save button  on the toolbar.   

Previewing report formats 
You can preview reports that you are customizing as you work on them. The 
previous exercise instructed you to preview the report at two separate points. 

1. To preview a report as you work on it, click the Preview button  on the 
toolbar.   

Parnes, Velano, Martinez & Co.

List of clients
Wednesday, April 30, 2014

ID  Description A/R Ending BalanceAverage Days to Collection Primary Address  Primary Phone 
AAC Advanced Advertising Consultan $5,396.00 0 9425 Main Street (215) 658-9588

Suite C
Albany, NY 12205

ABCP ABC Partnership n/a 0 456 State Street (800) 658-8548
Ann Arbor, MI 48104

ACEADVERTAce Advertising $6,450.00 0 12345 Lakeview Lane (734)766-0000
LaJolla, CA 92037

ALPHA Alpha Promotions n/a 5699 La Jolla Village Dnive (858)996-8741

LaJolla, CA 92037

ANDERSON Anderson, Joe &Kim n/a 435 Eight Mile Road (248)517-5858
Northville, MI 48167

ANIMAL Animal Shelter101 $55,049.64 1357 W.Huron Street (734)448-6214
Ann Arbor, MI 48105

Benton, Stephanie n/a 9565 PlacidWay (810) 523-9658
Brighton, MI 48114

BINGS  Bing, Sally n/a 0 5542 Lake View Street
East Lansing, MI 48823

BINGTA Bing, Ted &Angela n/a 0 5542 Lake View Street
East Lansing, MI 48823

BROWNI Brown, Jerald &Elizabeth $350.00 499 Powell Street (510)665-1214
Inglewood, CA 90312

CRAWFORD Crawford's Steak House $1,025.00 1418 FirstAvenue (619)882-9544
San Diego, CA 92037

GOLDEN Golden, Michael & Meredith n/a 9525 BellRoad (520) 568-2584
Scottsdale, AZ 85260

Printed by CATon 6/26/2014 at4:44 PM Page l
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Before the preview appears, you can modify report options in the Preview 
Custom Report Format dialog. This dialog offers the same tabs and fields as 
the Print Reports screen.   

 
2. When the report options are set to your liking, click OK to see a preview of the 

report. For this walkthrough, leave the default options.  

The preview opens in a separate window.   

 

Preview Custom Report Format

 Select the options to use to preview this report.

SelectionLayout

Dates
Report date:Period End Date2/29/2012

Filtering

OK Cancel

Preview CustmReport Format ÿ

Bak
K 1/2

ÿ 10

Parmes,Velano,Martine:& Co.

List of clients
Wednesday,April30,2014

ID Description A/R Ending BalanceAverage Days to CollectionPrimary AddressPrimary Phone
AC AdvancedAdvertising Coin $5,396.00 0 9425MginSreet (215)658-9588

SuiteC
Albany.NY 12205

ASCP ADCPartnerho n/a 456StateStreet (000)658-8540
Ann Arber, MI 48104

ACEADVERTAce Advertsing $5,450.00 12345 Lakeview Lane (734)766-0000
L3olla,CA 92037

ALPHA Alpha Promoors n/a 5699 Laollavilage Dve (858)996-8741
La3oll,CA 92037

ANDERSONAnderson,Joe&Km /a 0 435Eight Mile Road (248)517-5858
Northville MI 48157

ANML Animal Sheiter101 5+055 1357 W.Huron Street (734)448-6214
Ann Arbor,MI 48105

BENTON Benton,Sephaie / 9565PlacidWay 896-25(0a)

Bing,Sely n/a 5542LakeView Sre
EastLansing,MI48823

BINGTA Bing,Ted &Angee V/a 5542LakeViewSr
EastLansing,MI8823

BROWNOBrown,erd& $350.00 0 499 Powell Stret (510)665-1214
Ingleweod,CA 90312

CRAWFORDCrawfords Stk House $1,025.00 1418FistAvene (619)882-4544
San Diego.CA 92037

100105 Golden,Michel&Mee n/a 0 9525BellRoad (520)568-2584
Scottsdale,AZ 85260

Printedby CATon6/26/2014at4:48PM Page ?

 

 

  

 
   

 

 

  
 

  

  

 
 

 

     
      

 
 

     
 

     
 

     
 

      
 

     
 

     

   
 

    
 

      
 

     
 

      
 

 



Customizing Report Formats 

Practice CS Custom Formatting WalkThrough 37 

Notes 

 If you keep the preview window open, you can make further changes to the 
report and click the Preview button again to refresh the preview using the same 
report options. 

 You can click fields in the preview to drill down to other screens. 

 If a red line appears down the right side of the report preview, the page width is 
too wide. Adjust the printable area by dragging left on right margin of the ruler. 

Printing custom reports 
When you save a custom report format for the first time, it is added to the list of 
reports in the Print Reports screen, in the same category as the standard report on 
which it was based. 

You can print custom reports just like any other report, and can add them to report 
profiles. 

Note: You can also print custom reports directly from the Custom Formats screen 
by previewing the report and then clicking the Print button on the toolbar of the 
preview window. 

Restoring defaults for standard reports 
If you have customized a standard report format and decide later that you want to 
revert to the defaults for that report, you can easily do so. Customized standard 
reports can be identified by the different icon that appears next to them in the list of 
reports.    

To restore defaults for a standard report, follow these steps. For this walkthrough 
you added a new report, so you should not need to perform this procedure now, but 
it is included here for your information. 

1. In the Custom Formats screen, right-click the report and choose Edit from the 
context menu. The report opens in the editor. 

2. Right-click the report again and choose Restore Default from the context menu. 

Note: The Restore Default command is only available for standard reports that 
have been customized and that are open in the format editor. 

3. Click the Save button  on the toolbar.   



Customizing Report Formats 

38 Practice CS Custom Formatting WalkThrough 

Importing and exporting formats  
You can export the custom formats you create so they can be used in other firm 
databases. Exported formats can then be imported for use. 

Exporting 
In this exercise, you will export the report we created earlier. 

1. Choose File > Export > Custom Formats. The Export Custom Formats screen 
opens. 

2. Click the  buttons to expand the Reports item and the Lists item beneath it.   

3. Mark the checkbox for My Report.   

 
4. At the top of the screen, mark the File checkbox. This will export the format as a 

file, to be saved in a location of your choosing. 

5. Click the  button on the right end of the field.   

6. In the Browse For Folder dialog, navigate to the location where you want to 
save the custom format. For this exercise, choose your computer’s Desktop and 
click OK. 

7. Click the Export Selected button. Your custom format is exported as a file with 
an extension of .cfx. 

8. Click OK to dismiss the confirmation dialog. 

Note: If you want to send the custom format as an attachment to an e-mail 
message, mark the E-mail checkbox and click the button next to the field. You 
can then select recipients, and when you click the Export Selected button a 
message will be sent with the custom format as an attached file. 
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Importing 
If there are custom formats available to import, you can pull them into Practice CS 
using the Import Custom Formats feature. 

Follow these steps to import a custom format. 

1. Choose File > Import > Custom Formats. The Import Custom Formats dialog 
opens. 

2. Click the  button next to the Import Source field.   

3. In the dialog that opens, navigate to your computer’s Desktop and click OK. 

4. In the Import Custom Formats dialog, mark the checkbox for My Report.cfx   

 
5. To import the format, you would click the Import Selected button, but for this 

exercise click Cancel. 

Practice CS Library 
A Practice CS Library portlet is available for all dashboards. This portlet enables 
you to download custom formats created by others in the industry or additional 
formats created by our Development staff. You can also submit your own custom 
formats for consideration.  

To add this portlet to any dashboard, follow these steps. 

1. Open the dashboard where you want to add the portlet. 

2. Click the Select Portlets link in the upper right corner. 

3. In the Select Portlets dialog, mark the Practice CS Library checkbox, and click 
OK. 

Note: You may need to resize the portlet to view the information. Click and drag 
the edge of the portlet to resize as necessary. 

Import Custom Formats

Please enter a file or folder to import.

Import Source:C:1Userslu0011484\DesktopiMy Report.cfx

Remove lmported Files

Select the formats you would like to import and change the format description if necessary.

X Format File Format Description
My Report.cfx My Report

Import Selected
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4. Click the Custom Formats link at the top of the portlet.   

 

Hover your mouse pointer over the name of a report (or click a name) to see a 
report description and some basic instructions. 

Click the title of a report to see a sample. If the report looks like one you would like 
to use, click the Import icon  to add it to your list of available reports in Practice 
CS. Imported reports are added to the appropriate report groupings and are 
available on the Print Reports screen as well as the Custom Formats screen.   

Practice CS Library

PRACTICE CS? LIBRARY
Welcome Custom Formats Formulas Help Videos & PDFs Suggestions

New! Subscribe to Custom Format Updates!

Custom Formatting Service

Contribute to the User Community

Custom Format graphics available here!

Filter Custom Formats by keyword:

Type Title Source Note5 Import Updated Version

Billing Billing Analysis with Discount 2 12/17/13 2013.2.2

Billing Worksheet (No Cost) 12/17/13 2013.2.2
Billing Worksheet (Portrait Separate
Hrs/Units)

12/17/13 2013.2.2

Billing Worksheet (Portrait) 2 $ 2013.2.2

Billing Worksheet (Portrait) Alternate 1009Billing Worksheet (Separate Hrs/Units) ÿ 12/17/13
Detail Worksheet ÿ 12/17/13
Excel Export of Invoice Detail $ 11/06/12
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Security 
If your firm uses the security features of Practice CS to establish security groups 
with different levels of access to program features, you can grant or deny access to 
the Custom Formats setup screen by security group. You can also control access 
by type of report (e.g., invoices, statements, reports, labels & letters), or by 
individual report. 

1. To set options for firm security, choose Setup > Security Groups. 

Note: This command is not available unless you have marked the Enable Firm 
Security checkbox in Setup > Firm > Preferences. 

2. Select the Time Entry security group and click the Edit button. 

3. Click the  buttons to expand the Practice CS, Menu, and Setup Menu items.   

4. Click the Edit button in the lower left corner. 

5. Mark the Custom Formats checkbox under Setup Menu.   

 

You just granted access to the Custom Formats screen, and as you can see in the 
right pane, this also granted access to all custom formats data. However, for this 
example you want to restrict access to only custom formats for reports. To do so, 
you must modify security settings for custom formats data. 

  

Security Groups
Search:

Identification 
Description 

 Add New Clients Description:Time Entry
 Administrator Security Group information
Billing Privilege Selection: Privileges changed:
 Billing Invoice Approval ÿPractice CS  Practice CS
Office Administrator & HR ÿ Menu ÿMenu 

Partner ÿ File Menu ÿ Setup Menu 
View Menu CustomFormats

 Project Manager Actions Menu ÿ ÿ Data 
 Receipt and Adjustment Entryÿ ] Setup Menu - Custom Format Data 
 Staff Manager Firm  Invoices 

Offices  Statements 
[Staff  Reports 
Activities Labels & Letters

 Clients 
Security Groups
Groupings
Custom Fields
Templates
Taxes
Service Charges
Staff Rate Descriptions
 Recurring Bill Descriptions
CPE Course
Bank Accounts
Standard Text

 Custom Formats
Custom Portlets

 System Configuration 
 User Preferences

 Tools Menu
Data

Add iP3  Delete Jag Cancel 
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1. In the left pane, click the collapse button to collapse the Menu item, then click 
the expand buttons to expand the Data and Custom Format Data items. 

2. Clear the Invoices, Statements, and Labels & Letters checkboxes. Notice that 
each time you clear a checkbox, the right pane shows you the effects of your 
last change.   

 
Though you have now granted access to report-related custom formats, the reports 
that appear on that screen for members of the security group are determined by 
security settings for the Print Reports screen. 

For access to a report in the Custom Formats screen, a security group must first be 
granted privileges to print that report.  

1. Collapse the Data section and click the  buttons to expand the Menu, File 
Menu, and Print Reports items.   

2. Expand the Collection item under Print Reports. 

Security Groups
Search:Time Entry

Identification
Description

Add New Clients Description:Time Entry
 Administrator Security Group information 
Billing  Privilege Selection: Privileges changed:
Billing Invoice Approval Practice CS  Practice CS 
 Office Administrator & HR ÿMenu ÿ Data

Data  Custom Format Data Partner ÿ[  Activity Data Labels & Letters 
Project Manager Bank Account Data
 Receipt and Adjustment Entry  Client Data 
 Staff Manager  Contact Data

CPE Course Data
 Custom Field Data
 Custom Format Data

Invoices
 Statements 

Reports
Labels & Letters

Custom Portlet Data
 File Transfers Data

ÿ Firm Data 
Grouping Data
Invoice Data
 Office Data 
Receipt & Adjustment Data
Recurring Bill Description Data

Schedule Item Data
Security Group Data
Service Charge Data

 Staff Calendar Data
ÿ Staff Data

Staff Location Data
 Staff Rate Description Data
Standard Text Data

Add iP3  Delete Ja103 Cancel 
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3. Mark the checkboxes for the Accounts Receivable Ledger and Accounts 
Receivable Summary reports.   

 
You granted the security group privileges to print only two of the Collection reports. 
You can see that in addition to the two Collection reports, this group has printing 
privileges for some of the List reports (a checkmark would indicate access to all 
Lists, while a square denotes only partial access). 

Though this security group has been granted access to Reports in the Custom 
Formats screen, it will only be able to customize the reports for which it has been 
given specific printing privileges: in this case, some of the Lists, and the Accounts 
Receivable Ledger and Accounts Receivable Summary. 

 For this exercise, click Cancel to discard your changes. 

Note: When a staff member creates a custom report in the Custom Formats screen, 
all members of that person’s security group are given access to print and customize 
the new report. If the staff member belongs to more than one security group, only 
the groups that previously had access to the report on which the new report was 
based will have privileges for the new report. 

  

Security Groups
Search:Time Entry

Identification 
Description 

Add New Clients Description:Time Entry

Administrator Security Group information
Billing  Privilege Selection:  Privileges changed:
 Billing lnvoice Approval Practice CS - Practice CS
Office Administrator & HR ÿÿMenu ÿMenu 
 Partner ÿ Fil Menu -ÿ File Menu

ÿ New - Print Reports 
Project Manager ÿ Import ÿ Collection 
 Receipt and Adjustment Entry ÿ Export Accounts Receivable Summary
Staff Manager Print Reports

Time Entry
 Lists

Production
ÿ Collection

Accounts Receivable Applications
Accounts Receivable Ledger
Accounts Receivable Recap

Accounts Receivable Summary
Collection Summary
Invoice Receipts Analysis
Receipt and Adjustment Journal
Service Charge Journal

 Billing
Reconciliation

Print Labels & Letters
Print Invoices & Statements
Delete Firm
Backup
Restore
CS Connect

View Menu
 Actions Menu 

ÿ  Setup Menu
Firm
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Additional Examples 
This chapter offers a few examples that will take you through the customization 
process to create new reports. The exercises in the previous chapter familiarized 
you with customizing a listing report by adding and removing fields, editing field 
properties, and creating a formula. The following examples build upon those basic 
skills. 

Example: Removing a column from Billing Worksheet report 
Some firms may wish to remove the cost information from the Billing Worksheet 
report, because of what this information might reveal. In this exercise, you will 
remove the column and adjust the positioning of the remaining columns. 

Removing the Cost column 
hoose Setup > Custom Formats to open the Custom Formats screen. 

2. Expand the Reports item and then expand the Billing item. 

 

1. C  
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3. Double-click Billing Worksheet to open that report in the format editor.   

 

4. Click the Preview button  to see where the Cost column is situated on the 
report.   

5. Leave the default options selected in the Preview Standard Report Format 
dialog and click OK. The report opens in a preview window. Locate the Cost 
column.   

 

[PracticeCS-[Sample]-[CustomFormats]
Eile Edit View Actigns Fgrmat Setup Iools Help

Add

ÿ

0-

CustomFormats C Bilng Worksheet Fields
Invoices

Acvites by Aetivity Tye
Bling Workshes

uqq ReportHeader
CustomChart

Acinty lvoice Fomat Finm
CustomFormuls

Aetivity InvoiceFormat(2)
Engagement IvoiceFormat

ÿ Report

Ertry Detilby Engemert BillingWorks ÿ

Project Ivoice Fomat
Project wTme Eny Comens and Det Report Options

PaneProject wthDetaisIvoice Formal
Suatemerts ReportDate [Report Date Opoon]

AOpenes Statent Fot [DetallLineLabe1] [Detail Line Optioÿ1]
walkthrough

Reports
[Detail LineLabez] ]

[FlterOptionSelectonÿ18 [FiterOptionMethodÿ1
Biing [Filter OptionSelecton8 Properbes

led Tax Smmary 1
Bling Analysis [iter Option Selectinÿ] (Gena)

SPOM5 PrintW10.5
Invoice Journal [Filter Otn Seleÿ oeadd

ÿ ÿ Collection
Alignmert Certer

ÿ [Group By Selectionÿ] [Group by Sot onÿ1] Sze Modelp
PrintOn Pa

AdessLabels [Group By Selectionÿ2] [Group ly Sort on28
[Grou By Selection

ÿ
[Group By Selection [Group By Sort On4]

[Group BySortOn
[Group By Selectinÿ]
[Detall y Seledon] [DetailBy Soton] (Watermark)

ICheriRovDntinnnduANnabet reports bockground.

Main Contact infomationAging WIP and A/RA/R Open tem

For Help,pssF1 Curent Login CATCurrent Penod:4//2014-4/30/2014

Preview Standard Report Format ÿ X

Back--2
100 % K H 1/10

Parnes, Velano, Martinez & Co.

Billing Worksheet
Wednesday, April 30, 2014

January 1, 1900 - April 30, 2014

AAC Advanced Advertising Consultan
 Advanced Advertising Consultants Office: MICHIGAN Partner: SAM Manage: Associatet

Phone (Business): (215) 658-9588
9425 Main Street E-mail: cs.advancedad@g.mail.com
Suite C
Albany, NY 12205

* Billing Instructions:

AAC Advanced Advertising Consutan Time & Expenses Available to be biled
EngagementStaf Activity Date Rate per Hour/Unt  Hours/Unts1500 Amount Bill Amount Comments / Biller Note (*Biller)

Audit Services
AUDIT SAM NBRESEARCH11/11/11 awll 325.00 2.00 170.00 650.00
Audit Services Totals 2.00 650.00

Client Advanced Advertising Consutan Totals 2.00 170.00 650.00

ABCP ABC Partnership
ABC Partnership Office: MICHIGAN Partner: SAM Manager Associate:

Phone (Business): (800) 658-8548
456 State Street E-mail: info@ABCPartner.ship.net
Ann Arbor, MI 48104

*Billing Instructions:

ABCP ABC Partnership Time & Expenses Available to be biled
EngagementStaff Activty Date Rate per Hour/UnitHours/Units 7500 Amount Bill Amount Comments / Biller Note(*Biller)

Business Tax Services
BUSINESSTAXSAM NBRESEARCH12/06/11 Time: 275.00 1.50 127.50 412.50  Non-billable
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6. Close the preview window. In the format editor, select the text box labeled Cost 
in the GroupHeader3B section.  

ress the SHIFT key and select the fields directly below the Cost text box in the 
GroupHeader3C, Detail, GroupFooter6, GroupFooter5, GroupFooter4, and 
GroupFooter3B sections, as shown below.   

 

Note: Cost-related fields appear in multiple report sections despite not 
appearing in the report preview you generated. The additional sections are 
used when one or more groupings are selected prior to printing the report. 

8. Leave the items selected and scroll to the bottom of the report. 

 GroupHeader3B
[Billing Worksh etbligrtVdeksipbet]lient desoiption] Time&Expenses Available tobebiled
[Singular [Sin[sitag ular[Sir gulaSingular[SingularDateDate Rate per Hour/Unit Hours/Unit Cost Amount Bill Amount Comments / Biller Note(*Biller)

 GroupHeader3C
Beginning Balance [Biling [Billing [Billing]
 GroupHeader4
[Group Description(4]

 GroupHeader5
[Group Description(5)]

 GroupHeader6
[Group Description(6]

ÿDetail
[Billing [Bil[Bgling[Billing [eilling [Billing[BillitBillingExpense:[Billing] [Billin [Billing [Billing[Billing DeidiogtBitere[@dliejlWhgktbeksbilarrwteje

Comments: [Billing Worksheet comme
 GroupFooter6
[Group Description(6)] Totals [Billng] [Biling [Billing[Billing Dedsion

ÿ

 GroupFooter5
[Group Description(5)] Totals [Billing][Billing [Billing[Billinq Dedsion

A

[Group Description(4)] Totals [Billing [Billing [Billing [Billing Dedsion
ÿ GroupFooter3C
 GroupFooter3B

[Billing Worksheet Client Totals Desoiption] [Billingÿ
[Billingg

ÿ

 GroupFooter3A

7. P
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9. Press SHIFT again and select the remaining three cost-related fields, which are 
in the GroupFooter2, GroupFooter1, and ReportFooter sections. Skip the items 
in the GroupFooter3A section.   

 
10. Press the DELETE key. 

Note: If you are unsure whether you are selecting the right fields, you can double-
click a field to open a dialog that displays the formula. The cost-related fields all 
include “Cost” in their formulas. 
 
You can also select a field, scroll down to the OutputValue item in the Properties 
pane, and hover the mouse pointer over the value for that item. A tooltip appears 
showing the formula, which includes the word “Cost.”   
 

 

GroupFooter3A

Previous24PeriodHistory

Produced [client WF[client WF[Client WIF[client WF[Client WIF[Client WIF[Client WIF[client WF[client WF[Client WIF[Client WIF[client WIF[client
Adjusted [Client WIF[Client WF[Client WF[client WF[Client WF[Client WIF[Client WIF[Client WF[Client WIF[Client WF[ClientWIF[client WF [Client
Invoiced [AR [AR [AR [AR [AR [AR [AR [AR [AR [AR [AR [AR
Collected[AR Activity[ARActivity[AR Activity[AR Activity[AR Activity[ARActivity[AR Activity[AR Activity[AR Activity[AR Activity[ARActivity[AR Activity[ARAct

[Report Date [Report Date [Report Date [Report Date [Report Date [Report Date [Report Date [Report Date [Report Date [Report Date [Report Date [Report Date
[client WF[Client WF[Client WIF[client WF[client WIF[Client WIF[Client WIF[Client WIF[Client WF[Client WF[client WF[client WF [client

Adjusted [Client WF[Client WF[Client WF[Client WF[Client WF[Client WF[Client WIF[Client WF[Client WF[Client WF[Client WF[Client WF[Client
Invoiced [AR [AR [AR [AR [AR [AR [AR [AR [AR [AR [AR [AR

2
Collected [AR Activity[AR Activity[AR Activity[AR Activity[AR Activity[AR Activity[AR Activity[AR Activity[AR Activity[AR Activity[AR Activity[AR Activity[ARAct]

GroupFooter2

[Group Description(2)] Totals [eillng]
:

[Billing
L

[Billing[Billing Dedsion

 GroupFooter1

[Group Description(1)] Totals [Biling [Billing [Billing [Billing Dedsion

PageFooter

[Staff Date Time Stamp] Page [Pa]

ReportFooter

Report Totals [Biling [Billingg
ÿ

[Billing  [Billing Dedsion

 Contact Infomation Aging WIP and A/R A/R Open tems

Properties
ÿÿ

[Billing [Billing [Billing] [Billing[Billinq QeibiogCBitere[@illieWhgktbeksbdltrwtee (General)

Comments:[Billing Worksheet comme (Name) GroupFooter3_C
Height 0.1875
Width 0.75

[Billing [Billing [Billing[Billinq Dedsion X 5.5
Y 0.0625
Appearance

[Billing [Billing
ÿ

[Billing][Billinq Dedsion Align Decim False
AlignmentRight

[Billing [Billing [Billing]
Back Color Transpareni

[Billinq Dedsion 0

Font Tahoma.8pt
Fore Color 0.0.0
Line Spacin, 0

[Billing [Billingg [Billing][Billing Dedsion OutputForn#.##0.00
Output Forn Number.2,
Output Ovei

[Billing Worksheet live calculated cost(Billing, Worksheet)]
Previous 24 PeriodHistory 2 0.0.0

ate[Report Date [Report Date [Report Date [Report Date [Report Date[Report Date [Report Date Vertical Alig Top
[Client WIF [client WIF [client WIF [client WIF [client WIF [Client WIF [Client WIF [Client Behavior

ÿ Can Grow
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Adjusting column spacing 
Now that you have removed the Cost column, you may want to close up the space it 
left behind. Preview the report again to see how it looks with the column removed.   

 

There is now considerable space between the Hrs/Units column and the Amount 
column. You will close up that space. 

1. Close the preview window. 

n the format editor, select the Amount box in the GroupHeader3B section, 
press SHIFT, and select the items directly beneath it in the same sections as 
before, skipping the GroupFooter3A section. 

3. With the Amount column still selected, use the bottom scrollbar to scroll to the 
right edge of the report. 

Parnes, Velano, Martinez & Co.

Billing Worksheet
Wednesday, April 30, 2014

January 1, 1900 - April 30, 2014

AAC Advanced Advertising Consultan
 Advanced Advertising Consultants Office: MICHIGAN  Partner: SAM Manager Associate:

Phone (Business): (215) 658-9588
9425 Main Street E-mail: cs.advancedad@g.mail.com
Suite C
Albany, NY 12205

* Billing Instructions:

AAC Advanced Advertising Consultan Time & Expenses Available to be biled
Engagement Staff Activity Date Rate per Hour/Unit  Hours/Units Amount Bill Amount Comments / Biller Note (*Biller)

Audit Services
AUDIT SAM NBRESEARCH11/11/11 :awll 325.00 2.00 650.00
Audit Services Totals 2.00 650.00

Client Advanced Advertising Consultan Totals 2.00 650.00

ABCP ABC Partnership
ABC Partnership Office: MICHIGAN Partner: SAM Manager. Associate:

Phone (Business): (800) 658-8548
456 State Street E-mail: info@ABCPartner.ship.net
Ann Arbor, MI 48104

*Billing Instructions:

ABCP ABC Partnership Time & Expenses Available to be biled
Engagement Staff Activity Date Rate per Hour/Unit  Hours/UntsAmount BillAmount Comments / Biller Note(*Biler)

Business Tax Services
BUSINESSTAX SAM NBRESEARCH12/06/11 :awll 275.00 1.50 412.50  Non-bilable

Printed by CATon 7/1/2014 at 2:45 PM Page 1

2. I
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4. Press SHIFT and select the Bill Amount and Comment / Biller Note (*Biller:) 
boxes in the GroupHeader3B section and any items beneath them, skipping the 
GroupFooter3A section as well as the PageFooter section. You should now 
have three columns selected.   

 

Note: Do not select the lines in the GroupFooter sections, if possible. If you do 
move them, you can resize them later. 

5. Press the left arrow key several times to move all selected items to the left. 

6. Click in blank space to deselect all items, then select the two comment items on 
the right.   

 
7. Press SHIFT and the right arrow key to extend the right edges of the selected 

items to the margin. 

[Billing Billing Decslon Comrntsg [BBihgUBilkisgookiatbilernote] ÿ%Comments: [Biling Worksheetcomment]
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8. Preview the report.   

 
9. Close the preview window.  

10. If necessary, resize the lines around the subtotals in the GroupFooter sections. 
You can select multiple lines and resize them simultaneously. With lines 
selected, press SHIFT and the right or left arrow key to resize the lines. 

With some trial and error, you can get the report to look the way you want it. 

11. Click the Save button on the toolbar. This saves the customized standard report 
and changes the icon for it to indicate that it has been modified.    

Note: The report you just customized is already available in the Practice CS 
Library portlet. Add the portlet to any dashboard, then scroll to the Billing 
reports and click the icon to import The Billing Worksheet – No Cost report. 

Parnes, Velano, Martinez & Co.

Billing Worksheet
Wednesday, April 30, 2014

January 1, 1900 - April 30, 2014

AAC Advanced Advertising Consultan
Advanced Advertising Consultants Office: MICHIGAN  Partner: SAM Manager Associate:

Phone (Business): (215) 658-9588
9425 Main Street E-mail: cs.advancedad@g.mail.com
Suite C
Albany, NY 12205

*Billing Instructions:

AAC Advanced Advertising Consultan Time & Expenses Available to be biled
Engagement Staff Activity Date Rate per Hour/Unit  Hours/Unts Amount Bill Amount Comments / Biller Note(*Biler)

Audit Services
AUDIT SAM NBRESEARCH11/11/11 325.00 2.00 650.00  Non-bilable 
Audit Services Totals 2.00 650.00

Client Advanced Advertising Consultan Totals 2.00 650.00

ABCP ABC Partnership
ABC Partnership Office: MICHIGAN Partner: SAM Manager: Associate:

Phone (Business): (800) 658-8548
456 State Street E-mail: info@ABCPartner.ship.net
Ann Arbor, MI 48104

*Billing Instructions:

ABCP ABC Partnership Time & Expenses Available to be biled
 Engagement Staff Activity Date Rate perHour/Unt  Hours/UntsAmount Bill Amount Comments / Biller Note(*Billerc)

Business Tax Services
BUSINESSTAX SAM NBRESEARCH12/06/11 raw 275.00 1.50 412.50  Non-bilable 

Printed by CATon 7/1/2014 at 2:59 PM Page l
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12. Right-click Billing Worksheet in the list of reports and choose Restore Default 

from the context menu, then click the Save  button. This discards the 
changes you made in this exercise and reverts to the default version of the 
report.   

 
13. Close the Billing Worksheet report. 

Example: Adding comments to the Invoice Journal report 
In this example, you will add a comment line to the Invoice Journal report, which will 
print only when text has been entered in the Comment field in Time & Expense 
Entry. 

Adding a new report 
1. Click the Add Document  button on the toolbar of the Custom Formats 

screen and choose Add Report from the list of commands. The Report Format 
Wizard opens.   

2. In the Report Format Wizard dialog, enter Invoice Journal with comments in 
the first field. 

Reports
+ Lists
+ Production

Billing
Billed Tax Summary
Billing Analysis
Billing Worksheet
InvoiceJournal Add Invoice...

+ Collection Add Statement..
+ Reconciliation

Labels&Letters Add Report...
+ Address Labels Add Label/Letter...

File Folder Labels
Letters Copy Format

Edit
Restore Default

+

 

 
 

  
 

 
 

 
  

  
   

  

   
 

  
 



Additional Examples 

Practice CS Custom Formatting WalkThrough 53 

3. Expand the Billing folder in the list of standard reports and click the Invoice 
Journal.   

 
4. Click Finish to close the Format Wizard and open the new report in the format 

editor. 

Adding new items to the report 
1. Click the InvoiceDetail tab at the bottom of the screen.   

 
2. Hover the mouse pointer over the bottom of the Detail section until it turns into a 

double arrow, then click and drag the bottom boundary to open more space in 
the Detail section.   

 

3. Click the Text Box button  on the toolbar.   

Main Invoice Detail

InvoiceJoumalwithcomments

ReportHeader

Detail

[ID(Sheet [ID [ID(Sheet [ID(Sheet [Description(Sheet Entry adivity)]

ReportFooter

abl
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4. Click beneath the existing items in the Detail section and open a new text box, 
as shown below.   

 
5. Double-click the text box you just added. 

6. In the OutputValue Formula dialog, enter Comment: in the text area at the 
bottom.   

 
7. Click OK to close the dialog. The text box now contains the text you entered in 

the previous step. 

8. With the text box still selected, click the Bold button  on the toolbar.   

InvoiceJoumal with comments

ReportHeader

Detail

[ID(Sheet [ID(Sheet [ID(Sheet [Description(Sheet Entry adivity)]
ÿ
TextBox1

ReportFooter

 Output Value Formula

 Description:TextBox1

Invoice Detail System Fomulas
 Custom Formula  Date Parts

ÿÿFirm  Dates
ÿÿF Report Expressions

Invoice Detail Formatted Dates
Formatted Numbers
ÿMath
ÿReport Totals

Comment

Summary Properties Aggregate FunctionIF Expression

Calculation Method - Valid only for dates and numeric values (valid for dates: Avg. Min, Max).[Sum 

Running Total - Select this for running/interim calculations (must also set Summary Type).None
None

Reset Add Custom Fomula OK Cancel 
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9. Resize the text box to fit the text and click the Align Rights button  on the 
toolbar.   

 
10. In the Fields pane, click the  button to expand the Invoice Detail item, then 

scroll down and expand the Time/Expense Entry item.   

11. Scroll down to the comments item. Click and drag that item to the report, to the 
right of the text box you created.   

 
12. Resize the item so its right edge extends to approximately nine inches on the 

ruler. 

13. Press SHIFT and select the other text box you added, then click the Align Tops 

button  on the toolbar.   

Creating a PrintWhen condition 
Now that you have added the new Comment item to the report, you can specify the 
condition under which the item prints, which in this case is any time text exists in the 
Comment field on the Time & Expense Entry screen. To completely suppress 
printing of the item when no text is present, you must apply the same condition to 
both text boxes. If you apply the condition only to the Time/Expense Entry comment 
box, the Comment: box will still print. 

1. You can only apply the PrintWhen condition to one item at a time, so click in 
blank space to deselect all items. 

2. Select the Comment: box. 

InvoiceJoumalwithcomments

ReportHeader

Detail

[ID(Sheet [ID [ID(Sheet [ID(Sheet [Description(Sheet Entry acivity)]
ÿ

Comment:ÿ

777777//77777/

ReportFooter

lnvoiceJoumalwithcomments Fields
InvoiceDetai\Time/ExpenseEntry\comment

amount
ReportHeader amount is overridden

Detail Approved by

[ID(Sheet [ID [ID(Sheet [ID(Sheet [Description(Sheet Entry acdivity)]Description [Sheet [Billing [Billin! approved date
Billed Amount

Comment: [Time/Expense biller note
Biller Note Evaluated
calculated amount

Client
comments

ReportFooter Comments Evaluated

[Billing [Billin! complete
CostAmount
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3. In the Properties pane, scroll down and click the PrintWhen property in the 
Suppression group.   

 
4. Click the  button in the PrintWhen field.   

5. In the Print When Formula dialog, expand the Invoice Detail item, scroll down 
the list and expand the Time/Expense Entry item, then scroll down further and 
double-click the comments item.   

Properties

ÿ
Padding 0.0.0.0

Vertical Alig Top
Behavior
Can Grow True
Can Shrink False
Drill Down
Multi Line True
Visible True
Word WrapTrue
Summary
Calculation Sum
Group Total
Running Tot None
Summary TNone
Suppression
Hide DuplicFalse

Print W/hen
Required O
Suppress If0

PrintWhen
Specifies the formula for
determiningwhen thecontrol
shouldbeprinted

111
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6. Place the cursor to the left of the far right square bracket, press the space bar, 

and enter the following: 

< > "" 

Because that may be hard to read, here is the sequence of keystrokes: 

left angle bracket | right angle bracket | space | double quotation marks | 
double quotation marks 

The formula should now match this text:   

 
This tells Practice CS to print the contents of the text box when the comment 
field is not empty. 

7. Click OK. 

8. Select the Time/Expense Entry comment box and repeat this procedure starting 
at step 3. 

9. After you have set the PrintWhen condition for both items, click the Save button 

 on the toolbar.   

 Print When Formula

Description:
Invoice Detail\Time/Expense Entry\comments System Fomulas

 Billed Amount  Date Parts
 biller note ÿDates
 Biller Note Evaluated ÿÿ Expressions
@ calculated amount Formatted Dates
ÿ Client Formatted Numbers

comments ÿÿ Math 
a Comments Evaluated ÿReport Totals

a Cost Amount
- CPE Course Schedule Item 
 Custom Field

 date
Engagement

[Sheet Entry comment(Billing Decision sheet entry(Biling Decision)]

 Aggregate Function IF Expression

Select the numeric value from the field tree list.
 Summary Function:Sum 

Summary Grouping:Group4

Apply Clear

Reset Add Custom Fomula OK Cancel 

[Sheet Entry comment(BillingDecision sheet entry(BillingDecision))
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Previewing the report 
1. Click the Preview button  on the toolbar.   

2. On the Selection tab, select Custom in the Report date field and 12/31/2013 in 
the date field.   
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3. Click the Layout tab and mark the Include Invoice Detail checkbox.   

 

4. Click OK, then use the navigation buttons  at the top of the 
screen to scroll through the report. Notice that the report includes the Comment 
line for some items, but not for others.   

Preview Custom Report Format

Select the options to use to preview this report.

Description: Invoice Journal with comments

 Description override:

SelectionLayout
Direction: Page

Breaks:
Group by: (None) Ascending

(None) Ascending
(None) Ascending
Invoices Date Ascending ÿ

Detail by: Time/Expense EntiDate Ascending

Print Cover Sheet

Include Invoice Detail

QK Cancel
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5. Close the preview window. 

6. Click the Close button  on the toolbar. If prompted, click Yes to save your 
changes.   

Example: Adding a letter 
In addition to custom report formats, the format editor enables you to create custom 
letters that use data from Practice CS. In this example, you will create a simple 
letter informing clients of their current balances. 

1. Click the Add Document button  in the toolbar and choose Add 
Label/Letter.   

2. In the Label/Letter Format Wizard dialog, enter My Letter in the first field. 

Preview Custom ReportFormat
Back

100% K K 21/22

Parnes,Velano,Martine&Co.

Invoice Journal
December1,2013-December31,2013

2nvoiceReferene Date Cliet Descrption Time DpenssNet ProgressSurchargeDiscoutSales TaService TaAmourt
Invoics

Numbe

DetailtClietEngagemet Adity Descrption Type Da HoursUntsWIPAmourtBiledAdutedCaryover

CRAWFORDCONSULTING MHRPREPARATONPreparaon Time 12/05/135.00 1,750.001,775.7025.70 000

CRAWFORDCONSULTING MHRPREPARATTONPreparionTime 12/06/13 4.00 1,400.001,420.56 20.56 0.00
Comment: Meeting withpartes and

CRAWFORDCONSULTING MHRPREPARATIONPreparaton Time 12/09/13 2.50 875.00887.85 12.85 0.00

CRAWFORDCONSULTNG MHRPREPRATONPreon Time 12/10/13 1.25 437.50443.926.42 0.00
Comment:Testing system

CRAWFORDCONSULTING MHRWRARUPWrap Up Meetng Time 12/10/13 2.25 787.50799.07 11.57 00°0
Commen Demonstratonto dlentand ang

Wrap Up Meeng Time 12/10/13 2.25 787.50799.07 11.57 0.00
Comment:Demonstrationto dlientand bang

PrinredbyCATon7/2/2014at4:36P1 Poge21

+
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3. In the list of standard labels and letters, expand the Letters folder and click 
Client Letter.   

 
4. Leave Client selected in the Label/Letter type field and click Finish. The letter 

opens in the format editor.   
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Note: The Label/Letter type field governs the sort of contact for whom the label 
or letter can be printed. The available types are Client, Contact, Firm, Staff, and 
Office. For example, a label of type Client can be printed for your firm’s clients, 
while a label of type Contact can be printed for any of your firm’s contacts, 
regardless of any client affiliations.   

 

My Letter
.8.......9

ReportHeader
PageHeader
GroupHeader1
 Detail

[Report Date Header]

[Firm name 1]
[Contact Address address 1]
[Contact Address address 2]

[Primary City State Zip]

[Client name 1] 
[Contact Address address 1]
[Contact Address address 2]
[Mailing City State Zip]

Dear [Contact Salutation Name]:

In this text box you can type in the body of your letter. Please note that you can drag fields from the
field tree list above to automatically pull information from setup screens. You can change the font and
alignment of the contents of this box in the properties pane.

If you want further formatting options, you can replace this text box with a rich text box which will then
allow you to do things such as bold, underline or italicize specific words. Please note that in a rich text
box, fields from the tree list are not available to use.

Sincerely,

[Staff First Name Last Name]
[Firm name 1] 

GroupFooter1
 PageFooter
ReportFooter
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5. Double-click the text box containing the body of the letter (below the salutation). 
The OutputValue Formula dialog opens with the text displayed.   

 
6. Delete all of the default text and replace it with the following: 

This letter is to inform you of your current balance, per your request. We 
have calculated the amount to be $ 

Notes 

 You can copy text from other software and paste it into the text area. 

 The dollar sign you included in this step will appear before the balance 
figure, which you will now add using a formula. 

7. In the left pane above the text area, expand the Client, A/R, and Aging items. 

 Output Value Formula

Description: In this text box you can type in the body of your letter.
Client System Fomulas

Custom Formula  Date Parts
ÿFirm Dates
ÿReport Expressions

Client Formatted Dates
Formatted Numbers
Math

automatically pullinfomation from setup screens.You can change the font and alignment of the contents of thisbox in the
properties pane.

If you want furtherfomatting options, you can replace this text box with a rich text box which wil then alow you to do things such as
bold, underine oritalicize specific words. Please note that in a rich text box,fields from the tree list are not available to use.
Sincerely.

Summary Properties Aggregate FunctionIF Expression

Calculation Method - Valid only for dates and numeric values (valid for dates: Avg. Min, Max).[Sum 
Group Total - Select group section on which to reset (must also set Summary Type to SubTotal).

Running Total - Select this for running/interim calculations (must also set Summary Type).None
Summary Type - This can be set to SubTotal only for Group Total calculations.None

Reset Add Custom Fomula QK Cancel 
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8. Double-click the Ending Balance item. Practice CS inserts a formula into the 
text field.   

 
9. Add a period immediately after the formula, then press CTRL+ENTER twice to 

add new lines, and add a closing: 

Sincerely, 

 

Note: To add new lines, you must press CTRL+ENTER instead of ENTER. 

10. Click OK. 

 Output Value Formula

Description:In this text box you can type in the body of your letter.
ClientVA/RVAging\Ending Balance System Fomulas
ÿ Custom Formula  Date Parts
ÿÿFirm Dates
Report Expressions
ÿ Client Formatted Dates

24Period History -Formatted Numbers
ÿÿAR ÿMath

ÿÿActivity
ÿÿ Aging

 Beginning Balance
Ending Balance

 First Period
 Inner Period
 Last Period

This letter is to infom you of your curent balance, per your request. We have calculated the amount to be $[AR Aging(Key(Client).
Minimum Date, Report Date)]

Summary Properties Aggregate Function IF Expression

Calculation Method - Valid only for dates and numeric values (valid for dates: Avg. Min, Max).Sum 
Group Total - Select group section on which to reset (must also set Summary Type to SubTotal).

Running Total - Select this for running/interim calculations (must also set Summary Type).None
Summary Type - This can be set to SubTotal only for Group Total calculations.None

Reset Add Custom Fomula OK Cancel 
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11. Click the Preview button  on the toolbar. Leave the default options selected 
and click OK.   

 

Notes 

 Formulas can be added to regular text boxes but not to rich text boxes. 

 Rich text boxes provide more control over formatting. For example, you can 
use boldface or italics on individual words or characters. In a regular text 
box, any formatting applies to all of the text. 

12. Close the preview window and click the Save button  on the toolbar.   

13. Click the Close button  to close the letter.   

Example: Adding a label 
The format editor provides you the flexibility to customize the labels that you print 
from Practice CS. In this example, you will create a new label format for three-
column printing. 

1. In the list of custom formats, expand the Labels & Letters folder and the 
Address Labels subfolder. 

Preview Custom Letter Format ÿ X

Back--e
100 % K  1/21

Wednesday, April 30, 2014

Parnes, Velano, Martinez & Co.
880 Technology Drive
Ann Arbor, MI 48108

Advanced Advertising Consultants
9425 Main Street
Suite C
Albany, NY 12205

Dear :

o punowe a paee aey am rsanban ano had aueleq yuan no jo no wou o si laal s
be $5396.00.
 Sincerely,

Steve Miller
Parnes, Velano, Martinez & Co.
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2. Double-click the last label, Client – 8161 – 1” x 4”. The label opens in the format 
editor.   

3. Click the Detail line in the editor. 

 
4. In the Properties pane, change the ColumnCount property from 2 to 3 and 

press ENTER.   

 
Notice that the white printable area shrinks.   

 
5. Select the Contact name text box, then press SHIFT and select the remaining 

four text boxes.   

Cient-8161-1"x4"

ReportHeader

PageHeader

GroupHeader1

Detail
[Contact name]
[Clientname 1]

[Contact Address address 1]
[Contact Address address 2]

[Mailing City State Zp]

GroupFooter1

PageFooter

ReportFooter

Properties

AZ
(General)
[ewe N] Detail
Height 1

Appearance
BackColor Transparent
Behavior
CanGrow False
CanShrink False
KeepTogetheTrue
NewPage None
Visible True
Columns
ColumnCount3
ColumnDirect DownAcross

ColumnCount
Specifies the number of columns in
the detail section.

Client - 8161 - 1"x 4"

ReportHeader

PageHeader

GroupHeader1

Detail

[Contactname]
[Clientname 1]

[Contact Address address 1]

[Contact Address address 2]

[Mailing City State Zp]

GroupFooter1

PageFooter

ReportFooter
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6. With the boxes selected, hold down the SHIFT key and press the left arrow key 

several times until the right-hand boundary of the boxes fits within the printable 
area.   

 

7. Click the Preview button  in the toolbar. Accept the default options and click 
OK.   

 

Client-8161-1"x4"

ReportHeader

PageHeader

GroupHeader1

Detail
[Contactname]

[Client name 1]
[Contact Address address 1]

[Contact Address address 2]

[Mailling City State Zp]

ÿ GroupFooter1

PageFooter

Client - 8161 - 1"x 4"

ReportHeader

PageHeader

GroupHeaderl

Detail
[Contactname]

[Client name 1]

[Contact Address address 2]

[Mailing City State Zp]
GroupFooterl

PageFooter
ReportFooter

Preview Standard Label Format
Back--2

ÿ 100%

Advanced Advertising Consultants Crawford’s Steak House Dan Wilson
9425 MainStreet 1418 First Avenue  Dan &Joanne Wilson
Suite C San Diego, CA 92037 19408 RiverStreet
Albany, NY 12205 Bellevue, WA 98006

ABC Partnership Michael Golden
456 State Street  Michael &Meredith Golden 
Ann Arbor, MI 48104 9525 BellIRoad

Scottsdale, AZ 85260

Ace Advertising Consultants Jason Hama
12345 Lakeview Lane Jason Hamma
LaJolla, CA 92037 6794 Baker Road

Dexter, MI 48130

Alpha Promotions RonJones
5699 La Jolla Village Drive Ron&JennyJones
LaJolla, CA 92037 321Lane

Apartment 123
Bad Axe,MI 48111

Joe Anderson  Peysuew piemps
Joe&Kim Anderson Edward & Sylvia Mansfield
435 Eight Mile Road 1021 Lake Hollywood Drive
Northville, MI 48167 Los Angeles, CA 90064
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Notice that the labels now print across three columns. You can use the format 
editor to customize your labels to fit odd-sized label formats. 

8. Close the preview window. 

9. Click the Close button  on the toolbar. When prompted to save changes, 
click No.   

Example: Changing a report from landscape to portrait 
orientation 

If your firm decides to add columns to a portrait-orientation report, you may find it 
useful to switch the orientation of the report to landscape. There may also be 
reports that you want to change from landscape to portrait after removing columns. 

The Custom Reports screen in Practice CS can accommodate such changes. In 
this exercise, you will transform the Service Charge Journal report from portrait to 
landscape orientation. 

Changing the page settings 
1. Open the custom formats screen (Setup > Custom Formats). 

2. Expand the Reports item and then expand the Collection item. 

3. Double-click Service Charge Journal to open that report in the format editor.  

4. To change the orientation, choose File > Page Setup. The Report Settings 
dialog opens.   

 

Note: The Page Setup command is only available in the File menu when a 
report or other item is being edited in the Custom Formats screen. 

Report Settings

Preview
Top margin : 0.25

Bottom margin : 0.25
Page Setup Left margin : 0.25

Right margin : 0.25
Gutter : 000

Printer Settings Mirror margins

Styles

Global Settings
OK
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5. In the Report Settings dialog, click the Printer Settings button. 

6. In the Orientation box, click the Landscape option, then click OK.   

 

Adjusting the print area 
Now that you have changed the page settings, you can widen the print area of the 
report to accommodate additional columns. 

1. Use the horizontal scroll bar to scroll to the right edge of the report. Notice that 
the ruler at the top of the editor shows the print area to be eight inches wide.   

 
Eight inches of print area for an 8½-inch-wide, portrait-orientation report 
indicate that the report has ¼-inch margins on the left and right. If we use the 
same margins for the landscape-orientation report, the print area should be 
10½ inches wide. 

2. Hover the mouse pointer over the right edge of the report until it turns into a 
double-sided arrow.   

3. Click and drag the right edge of the report from 8 to 10½, as indicated by the 
top ruler, then release the mouse button.   

Notes  

 You may need to drag the margin a little, then use the horizontal scroll bar 
to scroll to the right, then drag a little more, and so on. 

Report Settings

Paper Size: Printer Default Preview

Width: 11.00

Page Setup Height: 8.50

Orentation
Default

Portrait
Printer Settings

Landscape

Collate: Printer Default

Styles Duplex: Printer Default

Paper Source:Printer Default

Global Settings
OK Cancel

Journal

Report DateHeader]

[Detail Line Header(1)]
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 You can also change the print width by entering a value in the Print Width 
field of the Properties pane in the General section. 

 
The report now has 10½ inches of lateral print area, giving you room to add 
more columns. Now you can move the last few columns to the right to open up 
space in the middle of the report, or add new columns on the right. 

Adjusting other items 
When you changed the size of your print area, you also moved the center of your 
report, and items that were centered on the portrait-orientation version are now off-
center. Similarly, any horizontal lines that separated areas of the previous report 
may no longer extend all the way to the right margin. In this part of the example, you 
will move and re-size these items to accommodate the wider print area. 

1. The first items to adjust are the gray horizontal lines that separate sections of 
the report. Select the top line in the PageHeader section. 

2. Press SHIFT and select the other line in the PageHeader section.   

 
3. Scroll down until you can see the gray line in the PageFooter section, and with 

SHIFT still pressed, select that line.   

 
4. With the lines still selected, press and hold the SHIFT and right arrow keys until 

all three lines reach the edge of the print area.   

Journal

[ReportDate Header]

[Detail Line Header(1)]

Journal

Total(Firm:SeestDue Service

A/R Charge)]ADatent Charge)]

[AR [Service Charge[Ledger Entry

Page[PageNumber]

[AR[Service Charge [Ledger Entry
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5. Click in blank space to deselect all items. 

croll back toward the left and up until you can see the top of the PageHeader 
section and the two text boxes that make up the report’s header. Select the top 
text box. 

7. Press SHIFT and select the other text box.   

 
hoose Format > Center in Form > Horizontally. The selected text boxes are 

now centered for the widened report. 

9. Click the Preview button  on the toolbar, choose Prior Period End Date in 
the Report date field, then click OK.   

Service
Charge)]

[Ledger Entry

[Ledger Entry

[Ledger Entry

[Ledger Entry

Page Numberj

[Ledger Entry

PageHeader

Firmname1]

[Singular Term(Firm:Service Charge)] Journal
ÿÿ [Detail Line Header(1)]

TotalFirm:SeesirDue
ID Description AyRCharge)]ADatent

6. S

8. C
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The preview enables you to see which items still need to be moved. You can 
see from the placement of the fields on the right how much space you gained 
by changing the report’s orientation. 

10. Close the preview window and click the Save button  on the toolbar to save 
the customized report. If necessary, you can revert to the default version as you 
did in the Billing Worksheet example.   

Example: Adding a custom chart 
Practice CS enables you to add custom charts and graphs featuring data relevant to 
the selected report. Use the Chart Wizard to create a new chart, pull data from the 
program, configure the chart or graph to appear the way you want it, and modify the 
titles, labels, and legend. 

For this exercise, we will add a pie chart to a copy of the Production Analysis report. 
The chart will show the firm’s margin for the period, grouped by client entity. 

Adding a new pie chart 
1. In the list of reports in the Custom Formats screen, expand the Production 

folder. 

2. Right-click the Production Analysis report and choose Copy Format from the 
context menu.   

Preview Standard Report Format
Back--2

ÿ 100% |K<>>1/1

Parnes, Velano, Martinez & Co.

Service Charge Journal
March 1, 2014 - March 31, 2014

Service Charge Service
ID Description Date Charge
ANIMAL Animal Shelter 101 03/01/2014 49.64
PROTO Prototype Design 03/01/2014 60.76

Total Service Charges 110.40
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3. Double-click the Production Analysis (2) report to open it in the formatter. 

4. Scroll down to the ReportFooter section, select the existing chart, and press the 
DELETE key to remove it from the report format. 

5. In the Fields pane, right-click the Custom Chart item and choose Add Custom 
Chart from the context menu.   

 
6. In the Chart Type tab of the Chart Wizard, select Pie/Doughnut from the Chart 

Group drop-down list, then select the Pie chart in the 3D subtab.   

 
7. In the Description field at the bottom of the tab, enter Margin, then click Next. 

Reports
Lists
Production

Production Analysis

Time and Expens Add Invoice...

Time and Expens Add Statement...
Timesheet Excep
Work-in-Process Add Report...

+.+.++
Billing Add Label/Letter...
Collection
Reconciliation CopyFormat

Project ManagementEdit
Client Management

+ Staff Management

Chart Wizard

sq   s  i -op a  dn a  

Chart Type Chart Group:Pie/DoughnutUpdate Existing Series
Appearance ÿ Swap Axes

Chart Data 2D 3D
Legend

Titles Doughnut C8

Axes 90

Legend Funnel 31

46

Pie

 Pyramid
53

Ring

Projection and Light

3D projection light

Description:
<<Previous Next >> Finish
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Modifying the palette and labels 
Now we’ll change the color palette for the chart and add labels that help identify the 
data in the chart. By default, these labels are surrounded by boxes, but we want to 
remove these boxes. 

1. From the list in the Palette subtab, select the Springtime palette.   

 
2. Click the Appearance subtab, click the representation of the pie chart to select 

it, then unmark the Use default (none) checkbox for the Marker item.   

 
3. Click the Drill down link next to the checkbox you just unmarked. 

4. Click the Drill down link for the Label item.   

 
5. Click the second drop-down list for the Border item and select (none).   

Chart Wizard

Select a color palette to apply to your chart or modify the appearance of individual graph elements.

Chart Type Palette Appearance.
Appearance Default

Chart Data Cascade
Sonngime
lceberg Legend

Titles Confetti
Greens

C8

Axes Benies 90

Autumn
Legend Murphy

Description:
Margin <ÿPrevious <<xeN Finish Cancel

Chart Wizard

Select a color palette to apply to your chart or modify the appearance of individual qraph elements.

Chart Type Palette Appearance
Appearance Series: Amount1
Chart Data Backdrop  Use default (none) Legend
Titles Style: (none) C8

Axes 90.00 90

Borderline Use default (none)
Legend 00 18 0088 31

Style: non...
46

46.00
19.00

Marker  Drill downUse default (none)
53.00

Alignment:Top Shape:Tiangle 90.00
10.00 12.00

Size: 10 Format: 26.00

Tooltip  Use default (none)

Alignment: Format:

Description:
Margin <<Previous Next >> Finish

Label Drill down

Alignment:Top Format:[Value:#.00)
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6. Click the representation of the pie chart to return to the top level of the 

Appearance subtab. 

7. Click the Drill down link for the Marker item (again). 

8. Click the second drop-down list for the Line item and select (none). This finally 
removes the boxes around the chart labels.   

 
9. Click Next to continue. 

Palette Appearance

Label

Border

Style: [Default)

Backdrop
(none)

Style: (Defaull)

Style: (Default) B

Palette Appearance

Marker

Backdrop

Style:(Default) PIOS

Line

Style: [Default)

Label (none)

Alignment:Top [00
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Adding a formula 
The next step in creating a chart is to add data. For this example, we need to 
construct a formula that subtracts cost from billable amount. The difference is the 
margin realized by the firm. 

1. In the Chart Data tab, mark the Use group descriptions checkbox. This tells 
Practice CS to use the descriptions from the chart grouping in the chart’s 
legend. For this report, we will group by client entity, so the various client entity 
descriptions will be used in the legend.   

 

2. In the Series box, highlight Amount2 and click the Delete button  to remove 
it. Do the same for Amount3.   

3. Click the Chart Series Formula Editor button to open the Chart Series Formulas 
dialog. You may recognize this dialog, because it’s the same as the one used to 
add formulas to reports and other formats. 

4. In the left pane at the top of the Chart Series Formulas dialog, expand the 
Production And Billing Posted item and double-click the billable amount item 
to add it to the formula.   

Chart Wizard

Add one or more series as needed to your chart, and set the name and chart type for each series.
Then use the Chart Series Formula Editor to specify a numeric formula for each series in the chart.

Chart Type Chart Settings
Appearance Use group descriptions X-axis label angle:0
Chart Data Chart is pivoted Legend
Titles C8

Axes Legend 90.00 90
Amount1

Legend 31.00 83.00 31

Amount2 46

ID_1 ID_2 Amount3 46.00
19.00 90

53.00 10

Series Series Settings 90.00 12.00 26

10.00 L26.00
Amount1
Amount2 Chart Type: Pie
Amount3

9

Chart Series Formula Editor

Description:
Margin <<Previous Next >> Finish
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5. Click the “minus” operator button.    
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6. Scroll down further in the left pane and double-click the production units cost 
item to complete the formula.   

 
7. Click OK to close the Chart Series Formulas dialog and return to the Chart 

Wizard. Then click Next to continue. 

Adding a chart title 
The next step is to add a title that will appear above the chart. The title is hidden by 
default; we will make it visible, change the default text, and format the new title. 

Chart Series Formulas

 Description:
Production And Billing Posted^production hours/units cost System Fomulas

 ending balance  Date Parts
 ending balance hours/units Dates
c non billable hours/units Expressions
 open aging 1 Formatted Dates
7 bulbe uado cn Formatted Numbers
ebujbe uado mn ÿMath
tbujbe uado mn
g buibe uado an
 production amount 

production hours/units
production hours/units cost
progress bill amount
Time/Expense Entry

Series Name:Amount1 Summary Function:Sum 

 Detail Line 2 Summary Grouping:Group1
[Aggregate Function(Sum, Production And Biling Posted bilable amount(Production And Biling Posted). 1. 1) - Aggregate Function 
(Sum, Production And Billing Posted production units cost(Production And Billing Posted). 1. 1)]l

IF Expression
Select the IF parameters from the field tree list.Operator Enter the criteria for the condition here.

IF
condition:

=

Then Otherwise
print: print:

Apply Clear

Reset Add Custom Fomula OK Cancel 
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1. In the Titles tab, verify that header is selected in the Titles box.   

 
2. Mark the Visible checkbox. 

3. In the Title properties box, delete the default text (Chart Title) in the text field 
and enter Margin to replace it. 

hange the font to Arial and click the bold and underline buttons. This changes 
the title to bolded Arial that is not underlined (the default title was underlined).   

 
5. Click Next to continue. 

Axes and legends 
The Axes tab is more applicable to other kinds of charts (such as bar graphs). Use 
the Axes tab to format the X and Y axes for the chart, including labels, tick marks, 
grid lines, and font format. 

Use the Legend tab to format the chart’s legend, including font formatting and the 
position and layout of the legend. For this exercise, we will modify the header text 
for the legend. 

lick Next until the Legend tab is shown. 

2. In the Header and Footer box, delete the default text (Legend) from the top text 
field and enter Groupings in its place. 

Chart Wizard

Add a tite and footer to your chart and set the appearance properties.

Chart Type Titles
Appearance xÿ

 visible 
Chart Data Header

Footer

Titles
poo C8

Axes 90.00 90

Legend 31.00 83.00
46

Title properties 46.00
19.00

Chart Title 53.00

Tahoma 90.00 12.00
10.00 26.00

opge

Border:
(no...

Description:
Margin <<Previous Next >> Finish

4. C

1. C
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hange the top font size to 10 and click the bold button.   

 
4. Click the Finish button to save the custom chart. 

Adding your chart to the report format 
Now that you have created a custom chart, you can add it to any relevant report. 

1. With the Copy of Production Analysis still open in the formatter, click and drag 
the new Margin custom chart from the Fields pane into the ReportFooter 
section.   

 

Production Analysis (2) Fields
Custom Chart\Margin
 Standard Chart 

ÿ GroupFooter3 ÿ Custom Chart
[Group Description(3] Totals [Produdion [Produdion [Produdion =100 * [Produdion =100 *[Produdion =100 * Margin

 Custom Formula

[Produdion =100 *
ÿ ÿ

[Produdion [Produdion [Produdion =100 * [Produdion =100 * opnpoid] ÿ Production And Billing Poste

[Group Description(1)] Totals[Produdion [Produdion [Produdion =100 * [Produdion =100 *[Produdion =100 *[Produdio
 PageFooter

[StaffDate Time Stny]

 ReportFooter
Report Totals [Producdion [Produdion [Produdion =100 *[Produdion =100 *: 0Ot= uopnpoud]opnpoid]

Margin 1

Properties

(General)

1.5
Width 1.5
X 0.5625
Y 0.5625
Appearance
Black And Whi False
Color PaletteSpringtime
Behavior
Visible True
Suppression
Print When
Required Optic PrintCharts
Suppress If La: 0

(Name)
The name of the control.

ÿ

3. C
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2. Click and drag a corner of the chart to fill more of the empty space in the 
ReportFooter section.   

 

3. Click the Save button  to save the report format.   

Previewing and printing charts 
When you preview or print a format that includes a chart, you must enable the chart 
in the layout options or it will not appear in the ReportFooter. 

1. With the Copy of Production Analysis still open in the formatter, click the 

Preview button  on the toolbar.   

2. In the Preview Custom Report Format dialog, click the Layout tab. 

3. In the Detail by field, select Client Entity. 

ReportFooter

ReportTotals [Produdion [Produdion [Produdion =100*[Produdion =100 *[Producion=100 * [Produdion =100 *=100 *

Margin

65.00 61.00 Groupin!

94.00 39.00
6
61

43.00 65
6

S6

95.00 81.00 42
24
75

42.00
24.00 75.00 81
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4. Mark the Print Charts checkbox.   

 
5. Click OK to preview the report with the chart included.   

 
6. Close the preview window. 

Preview Custom Report Format

Select the options to use to preview this report.

Description: Production Analysis (2)

 Description override:

SelectionLayout

Direction: Page
Breaks:

Group by: (None)  Ascending
(None) Ascending
(None) Ascending

 Detail by: Client Entity Ascending

Print Cover Sheet

Print Charts!

QK Cancel 

PreviewCustom ReportFormat

100% < 1/1

Parnes,Velano,Martinez&Co.

Production Analysis
April1,2014-April30,2014

...Hours/Units....ile
AdminNom-bilDllable

Tots %
Amourt
Bilable %

ID Name/Desopon %Hours/UntsTots Total Cost MarginTota
%

CCORP C-Corporaton E 0.00 0.00 3.50100.00 3.5041.18 1,225.0048.51 201.25332.39608.70 1,023.75805
Individual Bty 0.00 0.00 3.50100.00 3.5041.18 1,225,0048.51 315.0050.70 388.89910.00
Lmited Liablly Copy

47.80
LLC 0.00 0.00 1.50100.00 1.5017.65 75.002.97 105.0016.9071.43 -30.00-1.58

ReportTotals 0.00 0.00 8.50100.008.50100.002,525.00100.00621.25100.00406.441,903.75100.00

Margin

30.00

Groupings
910.00 IndvdualEntity

1023.75 d
Linted Liabity Companry
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Restoring the sample database 
After you have completed this walkthrough, you should restore the sample database 
that you backed up (see “Backing up the sample database” on page 2). Use the 
restored sample database to complete other Practice CS walkthroughs.  

1. From the File menu, choose Restore. 

2. In the Restore dialog, enter the path to the backup file that you want to restore, 
or click the  button to navigate to the backup location (typically X:\Program 
Files\Microsoft SQL Server\MSSQL$CREATIVESOLUTION\Data, where X: is 
the drive on the computer where the data resides).   

3. In the Restore File Location dialog, click the backup file that you want to restore 
and click OK. 

4, In the Restore dialog, enter a new name for the database in the New Firm name 
field.   

Note: When you restore the Sample database, you must give it a different 
name. The restore process in Practice CS does not overwrite an existing 
database, and Practice CS does not allow firm databases with duplicate names. 
Therefore, you will need to give the database a different name when you 
restore it (for example, Sample1). The name may contain only alphanumeric 
characters. 

 
 

Restore

Please select a backup ile or directory and enter a Firm name.

Backup file\directory:C:\Program Files [x86]Microsoft SQL Server\MSSQL.1\MSSQL\Data\CSP_0_Sample_20121051604

New Firm name: Sample1

Select the database you would like to restore:

Firm Name File Description Date
Sample CSP_0_Sample_20120516104Manual backup created on 05/16/2012 10:43:55 AM b 05/16/2012 10:44 AM

OK Cancel
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